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BioTek Instruments, Inc. 

Notices 

BioTek® Instruments, Inc. 
Highland Park, P.O. Box 998   
Winooski, Vermont  05404-0998  USA 

All Rights Reserved 

© 2013, BioTek® Instruments, Incorporated. No part of this publication may be 
reproduced, transcribed, or transmitted in any form, or by any means electronic or 
mechanical, including photocopying and recording, for any purpose other than the 
purchaser’s use without written permission of BioTek Instruments, Inc. 

Trademarks 

BioTek® is a registered trademark, and ELx800™, EL800™, and Gen5™ are trademarks 
of BioTek Instruments, Inc. Microsoft®, Windows®, and Excel® are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.  

All other trademarks are the property of their respective holders.  

Restrictions and Liabilities 

Information in this document is subject to change and does not represent a 
commitment by BioTek Instruments, Inc. Changes made to the information in this 
document will be incorporated in new editions of the publication. No responsibility is 
assumed by BioTek for the use or reliability of software or equipment that is not 
supplied by BioTek or its affiliated dealers. 
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E-Mail: tac@biotek.com 
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Phone: +49 (0) 7136 9680 

Fax: +49 (0) 7136 968 111 

E-Mail: info@biotek.de 

 

ELx800 Operator's Manual 



viii  | Preface 

Document Conventions 

Example Description 

 
This icon calls attention to important safety notes. 

Warning! 
A Warning indicates the potential for bodily harm and 
tells you how to avoid the problem. 

Caution 
A Caution indicates potential damage to the instrument 
and tells you how to avoid the problem. 

Note: Bold text is primarily used for emphasis. 

L This icon calls attention to important information. 

 
 

Revision History 

Rev Date Changes 

A 3/95 First Release 

B 7/95 Generic 

C 9/95 Add Errata sheet 

D 10/95 Incorporate Errata: Cal plate PN, cover text to UV. 

E 11/96 Added Panel Assay info. Added TVar parameter. Added Appendix D to 
include all reports. 

F 2/97 Added Notes including info on 384-well format. Updated Reuse of Standard 
Curves and Panel sections. Added Appendix E – KCJr for 384-well format. 

G 3/98 Added Liquid Test 1 and 2 to Chapter 4 – Performance Verification. Added 
Appendix F – Comparison, to show the differences between the ELx800 and 
the EL800. Added printer information. Changed plate type information to 
include 384-well and 72-/96-well Terasaki plate formats. Added reference to 
Quick Read on display. 

H 9/98 Modified Appendix B - Computer Control. Updated Elx800 and EL800 model 
comparison table in Appendix F. 

I 2/99 Incorporated Manual Updates. Changed European addresses. 

J 9/99 Changed printer-compatible description. Changed the number of samples 
necessary if there aren't controls, standards or blanks defined. Corrected the 
number of stored plates to 8. Corrected the positions for re-use of standard 
curves. Removed the "M" command from Appendix B- Computer Control. 

K 1/00 Added Liquid Test 3 to test 340 nm filters. Updated screens in Chapter 3. 
Updated chart in Appendix F. 

BioTek Instruments, Inc. 
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Rev Date Changes 

L 5/03 Preface: Updated contact information in Notices (page iii). Added Document 
Conventions (page v). Corrected errors in Safety Symbol text (page ix). 
Removed "screwdriver" from Package Contents, and added "BioTek QC 
Check Solutions for 405 nm" to Optional Accessories list (page 1-7). 
Removed About This Manual section (page 1-5). 
Updated contact information in Technical Support (Chapter 1). 
Modified appearance of display screens throughout. 
Revised lamp alignment section in Chapter 2. 
Chapter 4: Changed title to "Performance Verification and IQ/PQ/OQ Tests." 
Added IQ/PQ/OQ test procedure information. Clarified procedures for liquid 
tests. 
Replaced outdated Appendix E with instructions for using KCjunior to read 
384-well microplates. 
Added new Appendix G with two examples of assay kit instructions and 
directions for programming an assay. 
Made editorial and formatting changes throughout. 

M 9/03 Preface: Updated Warnings section. Updated Electromagnetic Compatibility 
section. Added “Consult instructions for use” and “In vitro diagnostic medical 
device” safety symbols. Expanded Intended Use Statement. 
Added Absorbance Test Plate to Optional Accessories list. 
Added KC4 startup information to Appendix E. 
Removed references to ELx800UV/EL800UV from Appendix F. 
Standardized the presentation of significant digits throughout. 
Changed “Abs” to “OD” throughout. 

N 10/04 Restructured manual according to new template. Removed references to 
“General Formula” throughout. 
Updated Chapter 4, Performance Verification and IQ-OQ-PQ Procedures. 
Added new Chapter 5, Maintenance and Decontamination. 
Added new Chapter 6, Troubleshooting and Error Codes. 
Restructured manual according to new template.  
Removed references to “General Formula” throughout. 
Updated Chapter 4, Performance Verification and IQ-OQ-PQ Procedures. 
Added new Chapter 5, Maintenance and Decontamination. 
Added new Chapter 6, Troubleshooting and Error Codes. 
Removed Computer Control portion of Appendix A; renamed Appendix to 
“Controlling the Reader With KCjunior™ or KC4™.” 
Added new Appendix B, Using 384-Well Geometry. 
Updated sample reports in Appendix C, Report Format. 
Removed previous Appendix A, Decontamination and Appendix C, Error 
Codes. 
Added new Appendix E, Instructions for Programming a New Assay. 

O 4/06 General: Changed “Bio-Tek” to “BioTek,” and “ELx800 Automated Microplate 
Reader” to “ELx800 Absorbance Microplate Reader.” Added Gen5 references 
and instructions wherever KC4 and KCjunior references and instructions 
were present. 
Cover: Updated BioTek logo to new graphic. 
Preface: Revised Hazards and Precautions, and removed Warranty and 
Registration Card. 
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Rev Date Changes 

Chapter 1: Updated Package Contents, Optional Accessories, and 
Specifications. Replaced 3-page Technical Support with 1-page Product 
Support and Service section. 
Chapter 2: Updated unpacking/packing instructions. Added new section, 
“Installing Software on the Host PC,” for Gen5, KC4, and KCjunior users. 
Chapter 3: In System Startup, incorporated information from Manual Update 
Rev. N2 that not all software features discussed in the manual are available 
on ELx800 readers with custom programmed software.  
Chapter 4:   
- Changed title from “Performance Verification and IQ/OQ/PQ Procedures” 

to “Instrument Qualification.” 
- Add Gen5 instructions for System Test and Absorbance Plate Test. 
- In Recommended Qualification Schedule, changed PQ frequency from 

monthly and semiannually to monthly and quarterly, and clarified criteria 
for running Liquid Tests. 

- In Absorbance Plate Test section, added a sample test plate report (and 
explanatory note) illustrating that values higher than the specified 0.000 
to 2.000 OD range may not have “PASS”/”FAIL” indications.   

- For Liquid Tests 1, 2, and 3, incorporated recommendation from Manual 
Update N2 to shake the plate or wait between pipetting and read steps. 

Appendix A: Changed title of appendix from “Controlling the Reader With 
KCjunior or KC4” to “Computer Control.” Added new section, “Controlling the 
Reader with Gen5.”  
Appendix B: Added Gen5 instructions for preparing and running a 384-well 
plate protocol with the ELx800NB.  Updated KC4 and KCjunior sections by 
specifying that the ELx800NB model must be used for running 384-well 
plates, and added screen shots that illustrate selection of the ELx800NB. 

P 10/06 Ch 3 Operation, clarified instructions for running Panel assays via the 
keypad. 
Ch 4 Instrument Qualification, replaced incorrect sample System Test report 
with a report run using an ELx800. 
Ch 5 Maintenance and Decontamination, added tips for storing and handling 
filters. 
Appx B, Using 384-Well Geometry, inserted step 13 to select a Read Type 
when using Gen5. 

Q 09/09 Throughout: Streamlined content to support reuse. Reduced white space to 
save paper. 
Preface: Updated Trademarks. Added Warranty and Product Registration 
section. Added Electromagnetic Environment and Compatibility cautions. 
Updated Intended Use statement and CE Mark Directives. Removed lists of 
figures and tables. 
Ch 1 Introduction: Removed sample plates from Package Contents. Added 
part number disclaimers. Updated optional accessories list. Corrected TAC 
fax number.  
Ch 2 Installation: Reorganized chapter. Added Product Registration section. 
Updated repacking instructions and figures. Added part number and 
packaging design disclaimers. 
Ch 3 Operation: Reorganized some sections. Under Printing Reports, added 
note explaining ‘Out’ indication on some reports. Under Reuse of Standard 
Curves, Limitations, changed assay position range from 31-55 to 32-55. 
Ch 4 Instrument Qualification: Updated System Test by explaining the Optics 
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Rev Date Changes 

Test and Autocal Analysis. Under Absorbance Plate Test, removed obsolete 
PN 9000547 6-Filter Test Plate. Under Liquid Testing, changed “μl” to “μL” 
and “ml” to “mL”; restructured  calculations section in Liquid Test 1; updated 
information on β-NADH powder in Liquid Test 3. 
Ch 5 Preventive Maintenance: Under Replacing and Aligning the Bulb, 
replaced previous instructions with reference to bulb replacement kit. 
Ch 6 Troubleshooting and Error Codes: Updated descriptions for error codes 
0601-0605, 0800, 0900. 
Appendix C Report Format: Added Overview section. Explained ‘Out’ 
indication on reports. 

R 06/11 Throughout: Removed references to outdated software KC4 and KCjunior. 
Updated parts lists, procedures, and photos to include the new USB port.  
Preface: Updated trademarks, Intended Use statement, warnings, 
precautions, and safety symbols. Added “Repacking and Shipping”. 
Ch 2 Installation: Updated “Install Software/Connect to Computer” to better 
support Gen5 installation and establishing communication between the 
reader and Gen5. 
Ch 3 Operation: Added “Getting Started with Gen5”.  
Ch 4 Qualification: Liquid Test 1, clarified Required Materials. Liquid Test 3, 
removed former Solution A, 10x concentrate PBS. 
Ch 6 Error Codes: Added Error Code 1201 
Removed former Appendix A, Computer Control and Appendix B, Using 384-
Well Geometry; integrated the information elsewhere in the manual. 

S 9/12 General: Removed references to the EL800. 
Preface: Updated copyright date and revision letter; added second bullet 
about the “IVD” label to “Intended Use Statement”; added “Service” and 
“Accessories” warnings to “Hazards”; added “Spare Parts” caution to 
“Precautions”; updated the wording of Directive 2004/108/EC ; updated 
Directive number for Low Voltage to 2006/95/EC; added “(if labeled for this 
use”) to Directive 98/79/EC. 
Chapter 2, Installation: Under “Establish Communications,” added a note to 
refer to instructions on the USB Driver Software CD and added the bullet 
“Try a different COM Port” to step 6. 
Chapter 4, Instrument Qualification: Updated Absorbance Test Plate section. 
Appendix B, Product Comparison: Removed because the EL800 is no longer 
available. 

T 4/13 Preface: Added EN 61010-2-081 to Directive 2006/95/EC Low Voltage 
(Safety) and EN 61010-2-101 to Directive 98/79/EC In Vitro Diagnostics. 
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Intended Use Statement 

• The ELx800 is an absorbance microplate reader. The performance characteristics of 
the data reduction software have not been established with any laboratory 
diagnostic assay. The user must evaluate this instrument and (if used) PC-based 
software in conjunction with their specific assay(s). This evaluation must include 
the confirmation that performance characteristics for the specific assay(s) are met. 

• If the instrument has an “IVD” label, it may be used for clinical and non-clinical 
purposes, including research and development. If there is no such label, the 
instrument may be used only for research and development or other non-clinical 
purposes. 
 

Quality Control  

It is considered good laboratory practice to run laboratory samples according to  
instructions and specific recommendations included in the assay package insert for the test 
to be conducted. Failure to conduct Quality Control checks could result in erroneous test 
data. 

 

Warranty & Product Registration 

Please take a moment to review the warranty information that shipped with your product. 
Please also register your product with BioTek to ensure that you receive important 
information and updates about the product(s) you have purchased. 

You can register online through the Customer Resource Center (CRC) at www.biotek.com 
or by calling 888-451-5171 or 802-655-4740. 

Repackaging and Shipping 

L If you need to ship the instrument to BioTek for service or repair, 
contact BioTek for a Return Materials Authorization (RMA) 
number, and be sure to use the original packing materials. Other 
forms of commercially available packaging are not recommended 
and can void the warranty. If the original packing materials have 
been damaged or lost, contact BioTek for replacement packing. 

 
 

BioTek Instruments, Inc. 



Warnings  |  xiii 

ELx800 Operator's Manual 

Warnings 

 

Operate the instrument on a level, stable surface and away from excessive 
humidity. 

Bright sunlight or strong incandescent light can reduce the linear performance 
range of the instrument. 

Measurement values may be affected by extraneous particles (such as dust) in the 
microplate wells. A clean work area is necessary to ensure accurate readings. 

When operated in a safe environment according to the instructions in this 
document, there are no known hazards associated with the instrument. However, 
the operator should be aware of certain situations that could result in serious 
injury; these vary depending on the instrument type. See Hazards and 
Precautions. 

 

Hazards  

The following hazard warnings are provided to help avoid injury: 

 

Warning! Power Rating. The instrument’s power supply must be connected to 
a power receptacle that provides voltage and current within the specified rating 
for the system. Use of an incompatible power receptacle may produce electrical 
shock and fire hazards. 

 
Warning! Electrical Grounding. Never use a plug adapter to connect primary 
power to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord directly to 
an appropriate receptacle with a functional ground. 

 Warning! Service. Only qualified technical personnel should perform service 
procedures on internal components. 

 Warning! Accessories. Only accessories that meet the manufacturer’s 
specifications shall be used with the instrument. 

 Warning! Internal Voltage. Always turn off the power switch and unplug the 
power supply before cleaning the outer surface of the instrument or removing its 
top case.  

 
Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument damage. If 
a spill occurs while a program is running, abort the program and turn the 
instrument off. Wipe up all spills immediately. Do not operate the instrument if 
internal components have been exposed to fluid. 

 
Warning! Unspecified Use. Failure to operate this equipment according to the 
guidelines and safeguards specified in this manual could result in a hazardous 
condition.  



xiv  | Preface 

BioTek Instruments, Inc. 

 
Warning! Software Quality Control. The operator must follow the 
manufacturer’s assay package insert when modifying software parameters and 
establishing reading methods. Failure to conduct quality control checks could 
result in erroneous test data. 

 
Warning! Reader Data Reduction Protocol. The onboard assay software will 
flag properly defined controls when they are out of range. The software will 
present the data with the appropriate error flags for the operator to determine 
control and assay validity. If the reader is operated via computer control, no limits 
are applied to the raw absorbance data. All information exported via computer 
control must be thoroughly analyzed by the operator. 

 

Warning! Hot Surface. The lamp is hot when the instrument is turned on. Turn 
off the reader and allow the lamp to cool down before attempting to replace it.  

 

Warning! Potential Biohazards. Some assays or specimens may pose a 
biohazard. Adequate safety precautions should be taken as outlined in the assay’s 
package insert. This hazard is noted by the symbol shown here. Always wear 
safety glasses and appropriate protective equipment, such as chemically resistant 
rubber gloves and apron. 

 

Precautions 

The following precautions are provided to help avoid damage to the instrument: 

 

Caution: Service. The instrument should be serviced by BioTek authorized 
service personnel. Only qualified technical personnel should perform 
troubleshooting and service procedures on internal components. 

 Caution: Spare Parts. Only approved spare parts should be used for 
maintenance. The use of unapproved spare parts and accessories may result in a 
loss of warranty and potentially impair instrument performance or cause damage 
to the instrument. 

 Caution: Environmental Conditions. Do not expose the instrument to 
temperature extremes. For proper operation, ambient temperatures should 
remain within the range listed in Chapter 1. Performance may be adversely 
affected if temperatures fluctuate above or below this range. Storage temperature 
limits are broader.  

 Caution: Sodium Hypochlorite. Do not expose any part of the instrument to 
the recommended diluted sodium hypochlorite solution (bleach) for more than 20 
minutes. Prolonged contact may damage the instrument surfaces. Be certain to 
rinse and thoroughly wipe all surfaces.  

 Caution: Power Supply. Only use the power supply shipped with the instru-
ment. Operate this power supply within the range of line voltages listed on it. 
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 Caution: Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the instrument for 
shipment. See Chapter 2. 

 Caution: Disposal. This instrument contains printed circuit boards and wiring 
with lead solder. Dispose of the instrument according to Directive 2002/96/EC, 
“on waste electrical and electronic equipment (WEEE)” or local ordinances. 

 Caution: Warranty. Failure to follow preventive maintenance protocols may 
void the warranty. See Chapter 5. 

 Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the user’s 
responsibility to ensure that a compatible electromagnetic environment for this 
instrument is provided and maintained in order that the device will perform as 
intended.  

 Caution: Electromagnetic Compatibility. Do not use this device in close 
proximity to sources of strong electromagnetic radiation (e.g., unshielded 
intentional RF sources), as these may interfere with the proper orientation. 
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CE Mark 

 
Based on the testing described below and information contained 
herein, this instrument bears the CE mark 

 

 See the Declaration of Conformity for more information. 

Directive 2004/108/EC: Electromagnetic Compatibility 

Emissions—Class A 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions 
and Line Conducted Emissions. Verification of compliance was conducted to the 
limits and methods of EN 55011—CISPR 11, Class A. In a domestic environment it 
may cause radio interference, in which case you may need to mitigate the 
interference. 

Immunity 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity. 
Verification of compliance was conducted to the limits and methods of the 
following: 

EN 61000-4-2, Electrostatic Discharge 
EN 61000-4-3, Radiated EM Fields 
EN 61000-4-4, Electrical Fast Transient/Burst 
EN 61000-4-5, Surge Immunity 
EN 61000-4-6, Conducted Disturbances from RFI 
EN 61000-4-11, Voltage Dips, Short Interruptions and Variations 

Directive 2006/95/EC: Low Voltage (Safety) 

The system has been type-tested by an independent testing laboratory and was found 
to meet the requirements of this Directive. Verification of compliance was conducted to 
the limits and methods of the following: 

EN 61010-1, “Safety requirement for electrical equipment for measurement, control and 
laboratory use. Part 1, General requirements.” 

EN 61010-2-081, “Particular requirements for automatic and semi-automatic laboratory 
equipment for analysis and other purposes.” 
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Directive 2002/96/EC: Waste Electrical and Electronic Equipment 

Disposal Notice: This instrument contains printed circuit boards and wiring with lead 
solder. Dispose of the instrument according to Directive 2002/96/EC, “on waste 
electrical and electronic equipment (WEEE)” or local ordinances. 

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use) 

• Product registration with competent authorities. 

• Traceability to the U.S. National Institute of Standards and Technology (NIST). 

• EN 61010-2-101, “Particular requirements for in vitro diagnostic (IVD) medical 
equipment.” 

 

Electromagnetic Interference and Susceptibility 

USA FCC CLASS A  

RADIO AND TELEVISION INTERFERENCE 

NOTE: This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. Like all similar equipment, this equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause 
interference, in which case the user will be required to correct the interference at 
his/her expense. 

In order to maintain compliance with FCC regulations, shielded cables must be used 
with this equipment. Operation with non-approved equipment or unshielded cables is 
likely to result in interference to radio and television reception. 

Canadian Department of Communications Class A  

This digital apparatus does not exceed Class A limits for radio emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadian Department of 
Communications. 

Le present appareil numerique n'émet pas de bruits radioelectriques depassant les 
limites applicables aux appareils numerique de la Class A prescrites dans le Reglement 
sur le brouillage radioelectrique edicte par le ministere des Communications du 
Canada. 
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User Safety 
This device has been type-tested by an independent laboratory and found to meet the 
requirements of the following: 

• Underwriters Laboratories UL 61010-1, “Safety requirements for electrical 
equipment for measurement, control and laboratory use; Part 1: General 
requirements.” 

• Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety 
requirements for electrical equipment for measurement, control and laboratory 
use; Part 1: General requirements.” 

• EN 61010 Standards, see CE Mark starting on page xvi. 
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Safety Symbols 

Some of these symbols may appear on the instrument or accessories: 
 

 
Alternating current 
Courant alternatif 
Wechselstrom 
Corriente alterna 
Corrente alternata 

 
Both direct and alternating current 
Courant continu et courant alternatif 
Gleich - und Wechselstrom  
Corriente continua y corriente alterna 
Corrente continua e corrente alternata 

 
Direct current 
Courant continu 
Gleichstrom 
Corriente continua 
Corrente continua 

 

Earth ground terminal 
Borne de terre 
Erde (Betriebserde) 
Borne de tierra 
Terra (di funzionamento) 

 

On (Supply) 
Marche (alimentation) 
Ein (Verbindung mit dem 
Netz) 
Conectado 
Chiuso 

 

Protective conductor terminal 
Borne de terre de protection 
Schutzleiteranschluss 
Borne de tierra de protección 
Terra di protezione 

 

Off (Supply) 
Arrêt (alimentation) 
Aus (Trennung vom Netz) 
Desconectado 
Aperto (sconnessione dalla rete 
di alimentazione) 

 

Caution (refer to accompanying 
documents) 
Attention (voir documents 
d’accompanement) 
Achtung siehe Begleitpapiere 
Atención (vease los documentos incluidos) 
Attenzione, consultare la doc annessa 

 

Warning, risk of electric shock 
Attention, risque de choc 
électrique 
Gefährliche elektrische schlag 
Precaución, riesgo de sacudida 
eléctrica 
Attenzione, rischio di scossa 
elettrica 

 
 

 

Warning, risk of crushing or pinching 
Attention, risque d’écrasement et 
pincement 
Warnen, Gefahr des Zerquetschens und 
Klemmen 
Precaución, riesgo del machacamiento y 
sejeción 
Attenzione, rischio di schiacciare ed 
intrappolarsi 

 

Warning, hot surface 
Attention, surface chaude 
Warnen, heiße Oberfläche 
Precaución, superficie caliente 
Attenzione, superficie calda 

 

Warning, potential biohazards 
Attention, risques biologiques potentiels 
Warnung! Moegliche biologische Giftstoffe 
Atención, riesgos biológicos 
Attenzione, rischio biologico 
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In vitro diagnostic medical 
device 
Dispositif médical de 
diagnostic in vitro  
Medizinisches In-Vitro-
Diagnostikum 
Dispositivo médico de 
diagnóstico in vitro 
Dispositivo medico 
diagnostico in vitro 

 

Separate collection for electrical and 
electronic equipment  
Les équipements électriques et 
électroniques font l’objet d’une collecte 
sélective 
Getrennte Sammlung von Elektro- und 
Elektronikgeräten 
Recogida selectiva de aparatos eléctricos y 
electrónicos  
Raccolta separata delle apparecchiature 
elettriche ed elettroniche 

 

Consult instructions for use 
Consulter la notice d’emploi 
Gebrauchsanweisung 
beachten 
Consultar las instrucciones de 
uso 
Consultare le istruzioni per 
uso 
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Introduction 

This chapter introduces the ELx800 Absorbance Microplate Reader, 
describes its hardware and software features, and provides contact 
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ELx800 Absorbance Microplate Reader 

The ELx800 is a single-channel reader-assay system, designed to automatically perform 
endpoint analysis for ELISA-based applications. The reader has the following capabilities: 

• All models: Measurement of the optical density of solutions in 6-, 12-, 24-, 48-, or 
96-well microplates.  

• “NB” models: Measurement of 384-well microplates and 60-, 72-, 96-well Terasaki 
trays as well as 6-, 12-, 24-, 48-, and 96-well plates.  

• Superior optical specifications, with an extended dynamic range of up to 3.000 
absorbance units in some read modes.  

• All models: A wavelength range from 400 nm to 750 nm.  

• “UV” models: An extended range from 340 nm to 750 nm.  

• Kinetic analysis can be performed using computer control (e.g., via Gen5 running 
on a host computer).  

• Assay definitions (consisting of protocols, templates and formulas) and the data 
they produce are managed by an onboard processor, via an LCD screen and 
membrane keypad.  

• Data can be stored onboard, printed, and/or uploaded to controlling software on a 
host computer.  

• Designed to serve as a stand-alone system, or as part of a larger laboratory data 
network, sending, receiving, and manipulating assay data as needed. 

Hardware Features 

• Single optics channel 

• Wavelength range of 400-750 nm (“UV” model range is 340 to 750 nm) 

• A 5-position filter wheel 

• A 2-line x 24-character LCD display  

• A membrane keypad with alphanumeric keys 

• X-Y carrier movement 

• Capability of reading 6-, 12-, 24-, 48- and 96-well microplates (“NB” model also 
reads 384-well and 60-/72-/96-well Terasaki microplates) 

• External 24-volt power supply, compatible with 100-240 V~ ± 10.0% @ 50 to 60 Hz 

• One RS232 serial COM port 

• One USB port  

• One parallel port 

BioTek Instruments, Inc. 
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Software Features 

• An easy-to-use, menu-driven interface 

• Endpoint calculations 

• Curve Fitting, with 4-parameter, cubic, quadratic, linear, 2-P, cubic-spline, and 
point-to-point methods 

• Transformation and Formula calculations for more complex mathematical 
operations, including Validations 

• Up to 75 assays can be programmed into memory and recalled instantly 

• Up to 10 results can be stored in memory 

Package Contents 

 Package contents and part numbers are subject to change. Please 
contact BioTek Customer Care with any questions.  

 
• ELx800 Absorbance Microplate Reader 

• Power cord (part number varies according to country of use) 

• Power supply (PN 61062) 

• Filter wheel with 4 standard filters: 405, 450, 490, and 630 nm, and one blank filter. 
“UV” model includes a 340 nm filter. 

• Operator’s Manual (PN 7331000)  

• Printer cable (PN 71072) 

• RS232 serial cable (PN 75034) 

• USB cable (PN 75108) with USB Driver Software (PN 7090204) 

• Dust cover (PN 7332040) 

Optional Accessories 

 Accessory availability and part numbers are subject to change. Contact 
BioTek Customer Care with any questions, or visit www.biotek.com 
and use the Accessories search tool. 

 
• Patented BioCell Quartz vessel: to obtain 1 cm fixed pathlength absorbance 

measurements (PN 7272051)  

• BioCell adapter plate assembly: can contain up to 8 BioCells (PN 7270512)  

• Replacement lamp for ELx800 (PN 7330513) 

ELx800 Operator's Manual 
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• Replacement lamp for ELx800NB, ELx800UV (PN 7330516) 

• ELx800 filters (PN 7334 + wavelength): 340 (UV model only), 405, 415, 450, 490, 
515, 540, 550, 562, 570, 590, 595, 600, 620, 630, 650, 660, 690, 750 nm 

• Terasaki plate adapter (PN 7330531) for 60-, 72-, and 96-well Terasaki plates for 
ELx800NB and ELx800RNB  

• BioTek absorbance test plate (PN 7260522)  

• Absorbance Liquid Test Solutions: 

 BioTek Wetting Agent Solution (PN 7773002) 

 BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; or PN 7120782, 125 mL) 

• Adapter to connect the reader to a USB-only printer (PN 75135) 

• Gen5 software (visit biotek.com or contact your local dealer for details) 

• ELx800 IQ/OQ/PQ Package (PN 7330538)  
 

Specifications  

All Models 

Light Source: Tungsten gas-filled bulb 

Dimensions: 42 cm x 38 cm x 18 cm (16.5" deep x 15" wide x 7" tall) 

Weight: 8 kg (18.5 lb. maximum) 

Environment: Operating temperature 18° to 40°C (64° to 104°F) 

Humidity: 10% to 85% noncondensing 

Power Supply: Input 100 to 240 V~ ± 10.0% @ 50 to 60 Hz 
Output +24 VDC, 2.1 A 

Standard Model 

Wavelength Range: 400 to 750 nm 

Filters: 10 nm half-bandwidth interference filters.  

User-accessible filter wheel. Up to 5 filters may be installed 
on the instrument at one time.  

Filters supplied: 405, 450, 490, and 630 nm. 

BioTek Instruments, Inc. 
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The following specifications apply to 96-well, flat- or round-bottom plates,  
single-wavelength measurements with a 50-second read (normal read mode): 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 1.0% from 0.000 to 2.000 OD at 405 nm 
± 3.0% from 2.000 OD to 3.000 OD @ 450 nm 

Repeatability (STD): ± 0.5% ± 0.005 OD from 0.000 to 2.000 OD @ 405 nm 

The following specifications apply to 96-well, flat- or round-bottom plates,  
single-wavelength measurements with a 30-second read (rapid read mode): 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 2.0% ± 0.020 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 2.0% from 0.000 to 2.000 OD @ 405 nm 

Repeatability (STD): ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

Ultraviolet/UV Model 

Wavelength Range:  340 to 750 nm 

Filters: 10 nm half-bandwidth interference filters.  

User-accessible filter wheel. Up to 5 filters may be 
installed on the instrument at one time.  

Filters supplied: 340, 405, 450, 490, and 630 nm. 

   The following specifications apply to 96-well, flat- or round-bottom plates: 

Optical specifications for 400-750 nm range (50-second read in normal read mode): 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 1.0%  ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 1.0% from 0.000 to 2.000 OD @ 405 nm 
± 3.0% from 2.000 to 3.000 OD @ 450 nm 

Repeatability (STD): ± 0.5% ± 0.005 OD from 0.000 to 2.000 OD @ 405 nm 

Optical specifications for 340-400 nm range (50-second read in normal read mode): 

Absorbance Measurement Range: 0.000 to  2.000 OD 

Accuracy: ± 2.0% ± 0.010 OD from 0.000 to 2.000 OD @ 340 nm 

Linearity: ± 2.5% from 0.000 to 2.000 OD @ 340 nm 

Repeatability (STD): ± 1.5% ± 0.005 OD from 0.000 to 2.000 OD @ 340 nm 

Optical specifications for 400-750 nm range (30-second read in rapid read mode): 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 2.0% ± 0.020 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 2.0% from 0.000 to 2.000 OD @ 405 nm 

Repeatability (STD): ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

ELx800 Operator's Manual 
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Optical specifications for 340-400 nm range (30-second read): 

Absorbance Measurement Range: 0.000 to 2.000 OD 

Accuracy: ± 2.5% ± 0.020 OD from 0.000 to 2.000 OD @ 340 nm 

Linearity: ± 2.5% from 0.000 to 2.000 OD @ 340 nm 

Repeatability (STD): ± 2.0% ± 0.010 OD from 0.000 to 2.000 OD @ 340 nm 

Narrow Beam/NB Model 

Filters: 10 nm half-bandwidth interference filters.  

User-accessible filter wheel. Up to 5 filters may be installed on the 
instrument at one time.  

Filters supplied: 405, 450, 490, and 630 nm. 

The following specifications apply to 96-well, flat- or round-bottom plates with a  
50-second read (normal read mode). 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 1.0%  ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 1.0% from 0.000 to 2.000 OD @ 405 nm 
± 3.0% from 2.000 to 3.000 OD @ 450 nm 

Repeatability (STD): ± 0.5% ± 0.005 OD from 0.000 to 2.000 OD @ 405 nm 

The following specifications apply to 96-well, flat- or round-bottom plates with a  
30-second read (rapid read mode). 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Accuracy: ± 2.0%  ± 0.020 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 2.0% from 0.000 to 2.000 OD @ 405 nm 

Repeatability (STD): ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

The following specifications apply to a 384-well plate. The minimum volume of fluid 
in a well to obtain the specified performance is 80 microliters. The specifications 
apply to the dual wavelength mode of read only. 

Absorbance Measurement Range: 0.000 to 3.000 OD 

Normal Read Mode: Dual wavelength (4 minutes, 45 seconds) 

Accuracy: ± 2.0% ± 0.020 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 2.5% from 0.000 to 2.000 OD @ 405 nm 

Repeatability (STD): ± 1.5% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

Rapid Read Mode: Dual wavelength (3 minutes, 25 seconds) 

Accuracy: ± 2.5% ± 0.020 OD from 0.000 to 2.000 OD @ 405 nm 

Linearity: ± 2.5% from 0.000 to 2.000 OD @ 405 nm 

Repeatability (STD): ± 2.0% ± 0.010 OD from 0.000 to 2.000 OD @ 405 nm 

BioTek Instruments, Inc. 
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Product Support & Service 

If your instrument or software fails to function properly, if you have questions about how 
to use or maintain your products, or if you need to send an instrument to BioTek for 
service or repair, please contact our Technical Assistance Center (“TAC”). 

Contacting the Technical Assistance Center 

TAC is open from 8:30 AM to 5:30 PM (EST), Monday through Friday, excluding 
standard U.S. holidays.  

Phone: 800-242-4685 (in the U.S.) or 802-655-4740 (outside the U.S.) 

Fax: 802-654-0638 

E-Mail:  tac@biotek.com 

Web:  www.biotek.com 

Please be prepared to provide the following information: 

• Your name and company information 

• A daytime phone or fax number, and/or an e-mail address 

• The product name, model, and serial number  

• The onboard software part number and version (available via the keypad 
by selecting UTIL > TESTS > CHKSUM) 

• Gen5 software version information (Help > About Gen5). 

• For troubleshooting assistance or instruments needing repair, the specific 
steps that produce your problem and any error codes displayed (see also 
Chapter 6). 

Returning Instruments for Service/Repair 

If you need to return an instrument to BioTek for service or repair, please contact the 
TAC for a Return Materials Authorization (RMA) number and the shipping address. 
Repackage the instrument according to the instructions at the end of Chapter 2, 
Installation. 

ELx800 Operator's Manual 
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Chapter 2 

Installation 

This chapter provides instructions for unpacking and setting up the 
ELx800 and for connecting printers and/or serial devices. 

Product Registration ............................................................. 10 
Unpacking and Inspecting the ELx800 ..................................... 10 

Remove the Shipping Hardware ......................................... 10 
Setting Up the ELx800 .......................................................... 13 

Select an Appropriate Location ........................................... 13 
Install the Power Supply ................................................... 13 
Power-Up and Run System Test ......................................... 14 
Change Global Default Settings (if needed) .......................... 14 
Connect a Printer to the ELx800 (for keypad control) ............ 15 
Install Additional Filters (if needed) .................................... 16 

Install Software/Connect to Computer (Optional) ...................... 18 
Attach the Cable .............................................................. 18 
Install Gen5 Software on the Host Computer ....................... 18 
Establish Communication .................................................. 18 

Preparing the ELx800 for Shipment ......................................... 20 
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Product Registration 

Please register your product with BioTek to ensure that you receive important information 
and updates about the products you have purchased. Contact the Customer Resource 
Center (CRC) at www.biotek.com or by calling 888-451-5171 or 802-655-4740. 

 

Unpacking and Inspecting the ELx800 

L Important! Save all packing materials. If you are sending 
the reader to BioTek for repair or replacement, use the original 
packing materials. Using other forms of commercially available 
packing materials, or failure to follow the packaging instructions 
at the end of this chapter, may void your warranty. Improper 
packaging that results in damage to the instrument may lead to 
additional charges. 

During the unpacking process, inspect the packaging, instrument, 
and accessories for shipping damage. If the instrument is 
damaged, notify the carrier and your BioTek representative. Keep 
the shipping boxes and the packaging materials for the carrier’s 
inspection. BioTek will arrange for repair or replacement of your 
instrument immediately. 

If the original materials have been damaged or lost, replacements 
are available from BioTek (PN 7332062). 

 

Carefully unpack the reader and retain the packing materials for future use.  

Inspect the shipping box(es), reader, and accessories for signs of damage.  

If the reader is damaged, notify the carrier and your manufacturer’s representative. 
Keep the shipping cartons and packing material for the carrier’s inspection. The 
manufacturer will arrange for repair or replacement of your reader immediately. 

See Preparing the ELx800 for Shipment at the end of this chapter for shipping 
instructions. 

Remove the Shipping Hardware 

1. Carefully turn the reader upside down on a level surface. 

BioTek Instruments, Inc. 
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2. Remove four mounting screws to detach the top cover from the base. Set the 
screws aside. 

3. Unhook the shipping straps from the post in the middle of the base. 
 

 

4. While holding the carrier, turn the reader’s base right side up. 

5. Remove two mounting screws to detach the shipping block from the base. 
Store the screws and block with the packaging materials. 

Figure 1: Remove the mounting screws (4) 

Top cover 

Shipping straps 

Post 

Mounting screws 
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Figure 2: Remove the shipping block 

6. Remove the shipping straps from the top of the carrier and store them with the 
packaging materials. 

7. If you need to install additional filters, do so now (see page 16). 

8. Place the top cover on the base. While holding the carrier, turn the reader 
upside down and replace the four mounting screws. When finished, carefully 
turn the reader right side up. 

BioTek Instruments, Inc. 
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Setting Up the ELx800 

Select an Appropriate Location 

Install the reader on a level surface in an area where ambient temperatures remain 
between 18°C (64°F) and 40°C (104°F). The reader is sensitive to extreme 
environmental conditions; avoid these conditions: 

• Excessive humidity: Condensation directly on the sensitive electronic 
circuitry can cause the reader to fail internal self-checks.  

• Excessive ambient light: Bright sunlight or strong incandescent light can 
reduce the linear performance range of the reader.  

• Dust: Optical density readings may be affected by extraneous particles (such 
as dust) in the microplate wells. A clean work area is necessary to ensure 
accurate readings. 

Install the Power Supply 

 

Caution! Power Supply. Use only the specified power 
supply to ensure proper operation of the unit. The ELx800 has 
a universal 24-VDC, 2.1 A power supply that functions from 
100 to 240 V~ (± 10.0%) @ 50 to 60 Hz without external 
switching. 

Caution! Electrical Grounding. Never use a plug adapter 
to connect primary power to the ELx800 power supply. Use of 
an adapter disconnects the utility ground, creating a severe 
shock hazard. Always connect the power supply cord directly 
to an appropriate receptacle with a functional ground. 

1. Connect the power cord to the external power supply. 

2. Plug the cord into the Power In port on the back of the reader, and tighten 
the nut to secure it. 

3. Plug the end of the power cord into an appropriate power receptacle. 

 
Warning! Power Rating. The power supply must be 
connected to a power receptacle that provides voltage and 
current within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical shock 
and fire hazards. 

ELx800 Operator’s Manual 
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Power-Up and Run System Test 

After you have installed the ELx800 and connected the power supply, turn on the 
reader to run a System Test. The on/off switch is located on the lower right side.  

If the test passes, a brief SYSTEM TEST PASS message will display, and then the 
main menu will appear (see below). If the test fails, the reader will “beep” and display 
an error code. If this happens, turn to Chapter 6 for a list of error codes.  

Following successful power-up, the Main Menu appears: 
 

R E A D Y   0 1 : 2 2 P M   0 7 / 2 3 / 0 9 

R E A D   D E F I N E  R E P O R T  U T I L 

 
   

 
   

 
   

 
 
The keypad has four buttons (called soft-keys) below the selectable options. To select 
a menu option, press its corresponding soft-key. See Keypad and Main Menu in 
Chapter 3 for additional instructions. 

Change Global Default Settings (if needed)  

BioTek defines certain settings onboard the reader before shipping it. Brief instructions 
for modifying the default settings are provided below. See Using the Utility Options 
in Chapter 3 for more information. 

To change the Date/format: 

1. Select UTIL > SETUP > DATE. 

2. Select the desired format: MM/DD/YY or DD/MM/YY. 

3. Use the arrow and number keys to change the date, if necessary.  

To change the Time/format: 

1. Select UTIL > SETUP > TIME. 

2. Select the desired format: 12 Hour or 24 Hour. 

3. Use the arrow and number keys to change the time, if necessary. When 
using the 12 hour format, use AM/PM option to change the setting. 

To change the Output option: 

1. Select UTIL > OUTPUT. 

2. Select Print, Computer or Both to specify where to send the results (only 
applicable when using the reader in standalone mode).  

To change the read-time prompt and read mode options: 

1. Select UTIL > READ. 

2. Select Yes or No and press Enter to proceed through each of the options.  

BioTek Instruments, Inc. 
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Connect a Printer to the ELx800 (for keypad control) 

L Connect a printer to the ELx800 only if you are running the 
reader in standalone mode (using the keypad). If you are using 
BioTek’s Gen5 software, skip this step. 

To avoid system instability, turn off the reader before 
connecting the printer. 

 

The ELx800 has a printer port to connect to parallel (Centronics) printers, such as HP 
Deskjet or Inkjet printers. (See Using the Utility Options in Chapter 3 for more 
information.) The port is shown in Figure 3 below. Use the parallel cable (PN 71072) 
provided with the reader. 

1. If the reader is on, turn it off. 

2. Place the printer near the ELx800. 

3. Attach one end of the supplied cable to the printer’s parallel port. 

4. Attach  the other end of the cable to the parallel port on the rear of the 
ELx800. 

5. Tighten the securing screws on both ends of the cable. 

6. Plug the power cord into an appropriate power receptical and turn the 
printer on. 

 BioTek offers an adapter to connect the reader to a USB-only printer. 
See “Optional Accessories” in Chapter 1. 

 For a list of compatible printers, use the Search tool at 
www.biotek.com, or call BioTek’s Technical Assistance Center. 

 

 

Figure 3: Connectors for power supply, printer (parallel), and computer  
(serial RS232 or USB), located on the reader’s rear panel 

 

ELx800 Operator’s Manual 
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Install Additional Filters (if needed) 

The filters that come with the reader are already installed in the internal, five-position 
filter wheel. Standard models have 405, 450, 490, and 630 nm filters. The UV model has 
an additional 340 nm filter. 

L Keep track of all filter locations. The physical locations of the 
filters must match the filter locations mapped in the reader’s 
software filter table. The filter wheel must have no empty 
locations; all locations must be filled with either a filter or a 
blank plug. Install all filters with the light direction 
arrow pointing downward. 
Store unused filters in a cool, dry place away from direct 
sunlight. The filters can be wrapped in a piece of lens paper 
to protect them from scratches and dust . 

 

To install additional filters or change the filter locations: 

1. Turn off the reader and disconnect the power cord. 

2. If you have not already done so, remove the reader’s top cover as described 
on page 10.  

3. The filter wheel is inside a small black box (filter wheel cover) directly 
under the end of the optics arm (see below). Remove the four thumbscrews 
from the filter wheel cover.  

4. The filter wheel sits on a pin and can be lifted off. Remove the filters by 
turning the wheel upside down over a lint-free cloth. The filters, which are 
labeled with the wavelength and light direction arrow, should easily 
slide out. Handle the filters from the edges. Do not touch the glass portion 
of the filter. Clean any filters that appear dirty with lens paper and 
isopropyl alcohol. 

5. Once the filters are installed in the wheel, place the wheel back on the pin, 
making sure it sits flat and meshes with the filter wheel drive gear. 

6. Install the filter wheel cover with the four thumbscrews.  

7. Reinstall the top cover as described on page 10. 

8. Reconnect the power supply and cable. 

BioTek Instruments, Inc. 
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Figure 4: Accessing the filter wheel 

 

Check the Reader’s Filter Table 

If you installed or moved filters, ensure that the ELx800’s filter table (the reader’s 
software reference for filter locations) matches the physical location of the filters. 
To check or change the software filter table: 

1. Turn on the reader and select UTIL > SETUP > FILTER. 

2. The wavelength for Filter #1 will be displayed. To change a filter wavelength 
value, use the keypad to enter a number at the cursor location. The cursor 
will automatically advance to the next editable location. Press the Enter key 
to save the value and move to the next filter. 

E N T E R                    

F I L T E R # 1  W A V E L E N G T H : 4 0 5  

3. After entering the last filter, press the Main Menu key to return to the main 
menu. 
 

ELx800 Operator’s Manual 
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Install Software/Connect to Computer (Optional) 

The ELx800 is equipped with two communication ports: Serial (RS-232) and USB. Both 
ports are located on the back of the reader. The ports allow the reader to communicate 
with a computer using the BioTek Gen5 software. It also allows for upgrades to the ELx800 
basecode (on-board) software. 

 The reader’s default communication parameters are: 9600 Baud Rate, 
8 Data Bits, 2 Stop Bits, no parity. The baud rate can be changed, 
however, Gen5 requires 9600. The other settings cannot be changed. 
See Using the Utility Options in Chapter 3 for more information. 

Attach the Cable 

• Two communication cables are included in the accessories box. Determine which 
cable is supported by the host computer.  

• Connect one end to the appropriate port on the reader and the other end to the 
appropriate port on the host computer. 

Install Gen5 Software on the Host Computer 

L 
If applicable, install Gen5 on the host computer. There is a 
certain sequence of events that must be followed to ensure 
that the software is properly installed and configured. Please 
follow the instructions provided in Gen5 Getting Started Guide 
to install the software. 

 

Establish Communication  

 If using the USB cable, refer to the instructions that shipped with the 
USB Driver Software CD to install the necessary drivers.  

1. Start Gen5 and log in if prompted. The default System Administrator password is 
admin.  

2. Go to the Gen5 main screen: 

• Gen5 version 2.x users: From the Task Manager, select Setup > Go to System 
Menu. 

• Gen5 version 1.x users: From the Welcome screen, select System Menu. 

3. Select System > Instrument Configuration and click Add. 
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4. Set the Reader Type to ELx800. 

5. Set the Com Port to the computer’s COM port to which the reader is connected. 

• If using the USB cable, the information can be found via the Windows Control 
Panel, under Ports in the Hardware/Device Manager area of System Properties 
(e.g., Serial Port (COM5)).  

6. Click Test Comm. Gen5 attempts to communicate with the reader. If the 
communication attempt is successful, return to the Gen5 main screen. 

If the communication attempt is not successful, try the following: 

• Is the reader connected to the power supply and turned on? 

• Is the communication cable firmly attached to both the reader and the 
computer? 

• Did you select the correct Reader Type in Gen5? 

• If applicable, did you install the USB driver software? 

• Try a different COM port.  

• Make sure the reader display is at its Main Menu. 

If you remain unable to get Gen5 and the reader to communicate with each other, 
contact BioTek’s Technical Assistance Center.  
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Preparing the ELx800 for Shipment 

L Important! Failure to properly package the reader increases the 
likelihood of damage to the reader during shipping. The shipping 
system stabilizes the reader’s mechanical components, which 
would otherwise be free to move around during shipping.  

If you need to send the reader to BioTek for service or repair, use 
the original packing materials. Other forms of commercially 
available packing materials are not recommended and can void 
the warranty. If the original materials have been damaged or lost, 
contact BioTek for replacements (PN 7332062; see Chapter 1 for 
contact information). 

 
Warning! If the reader has been exposed to potentially hazardous 
material, decontaminate it to minimize the risk to all who come in 
contact with the reader during shipping, handling, and servicing. 
Decontamination prior to shipping is required by U.S. Department 
of Transportation regulations. 

 

 Packing materials are subject to change. If the instructions in this 
section do not apply to the materials you are using, please contact 
BioTek’s Technical Assistance Center for guidance. 

 Refer to the drawings on the following pages when performing these 
steps.  

1. Contact BioTek’s Technical Assistance Center for an RMA (Return Materials 
Authorization) number and the shipping address. 

2. Decontaminate the reader before repackaging it. See Chapter 5 for 
instructions. 

3. Move the carrier to its full-out position, if not already there. (If necessary, turn 
the instrument on to home the carrier.) 

4. Turn off the instrument and unplug the power supply. 

5. Wrap the shipping straps around the carrier. 

6. While holding the carrier, carefully turn the instrument over and hook the 
shipping straps over the post in the middle of the base. 

7. Remove the four mounting screws. 

8. Lift the base off the cover and turn it right side up. 

9. Install the shipping block: place the groove in the block over the shaft and 
attach the two mounting screws. 
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10. Turn the reader over and install the top cover. 

11. Turn the reader right side up, place it in the plastic bag, and attach the end 
caps.  

12. Place the reader with the end caps into the box. Place the accessories tray onto 
the end caps, and the power supply into a bubble bag. Place the power supply 
on the tray. 

13. Close the box and tape it shut. Write “RMA” on the outside of the shipping 
container, and ship the box to BioTek. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Secure the carrier 
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Figure 6: Attach shipping straps, remove mounting screws 

 

 

 

 

Figure 6: Remove the mounting screws and lift the base off the cover
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Figure 7: Install the shipping block 
and then replace the cover 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8: Attach the end 
caps (2) and place the 

reader in the shipping box End caps (2) 

ELx800 Operator’s Manual 



24  | Chapter 2: Installation 

BioTek Instruments, Inc. 

 



Chapter 3 

Operation 

This chapter primarily describes how to operate the reader using its 
keypad. Instructions for getting started with Gen5 software are also 
provided. 

Getting Started with Gen5 ................................................. 27 
Keypad and Main Menu ..................................................... 28 
Performing a “Quick Read” ................................................ 29 
Creating or Editing an Assay .............................................. 30 

Create a New Assay ..................................................... 30 
Edit an Existing Assay .................................................. 30 
How to Name an Assay ................................................ 31 
Programming Note ...................................................... 31 

Define (Method, Map, Formula, Curve) ................................ 32 
DEFINE  METHOD ..................................................... 32 
DEFINE  MAP ........................................................... 34 
DEFINE  FORMULA .................................................... 44 
DEFINE  CURVE ........................................................ 53 

Reading a Microplate ........................................................ 58 
Select Assay ............................................................... 58 
Run-Time Prompts ....................................................... 58 
Enter Number of Samples ............................................. 59 
Enter Plate ID ............................................................. 59 
Enter Sample ID ......................................................... 60 
Prompts for Well Location ............................................. 60 
Beginning the Plate Read .............................................. 60 

Printing Reports and Assay Lists ......................................... 61 
Results Report ............................................................ 61 
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Editing Standard Outliers .............................................. 62 
Printing Results ........................................................... 63 
Map ........................................................................... 63 

Using the Utility Options ................................................... 64 
Setting the Date and Time ............................................ 64 
Viewing/Editing the Filter Table ..................................... 65 
Specifying Data Output and Reporting Options ................. 65 
Selecting Read Options ................................................ 66 
Changing the Baud Rate ............................................... 67 

Recommendations for Optimum Performance ....................... 68 
 

 

 

L Some readers have custom programmed assays installed. 
Not all features of the software discussed in this chapter are 
available on custom instruments. Please contact BioTek’s 
Technical Assistance Center (TAC) if you have any questions 
about the assays on your reader 

All users should read Recommendations for Optimum 
Performance on page 68. 

To read a 384-well plate, Gen5 software is required. The plate 
type is selected within the Procedure dialog. 

 

 

 

 

 

BioTek Instruments, Inc. 



Getting Started with Gen5  |  27 

Getting Started with Gen5 

These instructions briefly describe how to create and run an Experiment in Gen5. For more 
information, or if the instructions below do not match what you see in Gen5, refer to the 
Gen5 Getting Started Guide and Help system. 

For Gen5 version 2.x users: 

1. Start Gen5.  

2. If the Task Manager appears, select Read Now > New and skip to step 4. 
Otherwise, select File > New Task from the main view. 

3. Select Read Now > New. Gen5 will open the procedure dialog. Go to step 4. 

 For Gen5 version 1.x users: 

1. Start Gen5. If the Welcome screen appears, select Read a Plate and skip to 
step 4. Otherwise, select File > New Experiment from the main view. 

2. Select Default Protocol and click OK. Gen5 will open the Experiment 
workspace, which includes the Protocol menu tree and Plate screen. 

3. Select Plate > Read or click the Read Plate icon. The Procedure dialog will 
open. Go to step 4. 

For any version: 

4. Select a Plate Type. 

5. Click Read to open the Read Step dialog.  

6. Select a Read Type.    

7. Select or enter the wavelength(s) at which the plate will be read. 

8. Define other reading parameters as desired. Click the Help button for 
assistance. 

9. When complete, click OK to return to the Procedure dialog.  

10. Click OK to save and close the Procedure dialog. 

• Gen5 version 1.x only: The Plate Reading dialog will open. Enter any 
desired information, place the plate on the carrier, and then click READ 
to begin the plate read. If the Save As dialog opens, enter a File name, 
choose a file location (Save in:) and click Save. 

11. Click OK when the Load Plate dialog appears. The plate will be read. 

• To view the raw data results, use the Data drop-down arrow in the 
Plate screen to select one wavelength. The results will be displayed for 
the selected wavelength. Repeat, for other wavelengths. 

• To analyze, manipulate, or print results, Protocol parameters should be 
defined. Refer to the Gen5 Help system for instructions. 
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Keypad and Main Menu 

The ELx800 features a keypad and 2-line x 24-character LCD display: 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

LCD 

Soft-keys: 
Press a key to 
choose  
the matching 
menu option. 

Main Menu  

Date and Time 

Use the arrow keys  
to move the cursor  
in the LCD display. 

Press Options to  
scroll through options 
or the alphabet. 

Press Shift+Options 
to scroll backward 
through options or  
the alphabet. 

 

The Main Menu offers these options: 

• READ (or, press the key labeled READ) to read a plate. You must select a 
preprogrammed assay or previously defined protocol.  

• DEFINE to create or edit a reading and data reduction protocol. You will be 
prompted to select an existing assay. Assign a new name to create a new 
protocol or modify the parameters, as needed, to fine-tune the selected assay. 

• REPORT to print stored protocol results; requires a previously run assay with 
valid data. 

• UTIL to view or change settings or to run onboard utilities. 
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Performing a “Quick Read” 

L On some readers, assay number 01 allows for quick reading 
and simple programming. If available on your reader, it 
appears as “_Quick Read” on the display.  

Most of the options available in assays 02 through 55 (and 
described in this chapter), are unavailable for programming 
within the _Quick Read assay. 

 

The default Quick Read assay settings are shown below. You can edit the 
wavelength(s) but the Map is fixed. Read-time prompts can be disabled via UTIL > 
READ (see page 66). 

Method: Single Wavelength 405 nm (editable) 

Map:  

• 96-well plate geometry 

• Blank on Air 

• Auto mapping 

• Map starting location A1 

• Samples only (no blanks, standards or controls) 

• Sample count prompted at runtime  

To run the Quick Read assay: 

1. Select READ at the main menu. 

2. Select assay number 01_Quick Read and press Enter. 

3. Choose Single or Dual wavelengths and press Enter. 

4. Select the measurement wavelength. For Dual readings, use the arrow key 
to move the cursor to the reference wavelength and select it. Press Enter. 

5. If prompted, enter the number of samples on the plate and press Enter. 

6. If prompted, enter a Plate ID and press Enter. 

7. If prompted, enter a Sample ID and press Enter. 

8. When the plate read is complete, Generating Report Results will display 
for a few moments and then the results report will print. 
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Creating or Editing an Assay 

Use the DEFINE main menu option to specify the data acquisition and reduction 
parameters for a new assay, or to modify a previously defined assay. Assay parameters are 
organized into these categories: 

Option Description Turn to: 

METHOD Type of reading: single or dual, wavelengths, and 
plate geometry. 

page 32 

MAP Plate layout: the arrangement of samples, 
standards, controls, and blanks on the plate. Map 
the plate manually, or let the reader define the map 
automatically. 

page 34 

FORMULA Data reduction steps: the cutoff, transformation, and 
validation formulas. Create variables to be used 
within formulas. 

page 44 

CURVE Plotting a curve: the curve fit and x/y axis types; 
lin/log. Specify how to handle standard outliers. 
Enable or disable the extrapolation feature. 

page 53  

 
 

L “NB” models using 384-well geometry do not have access to 
map, formula, or curve options. The 384-well plate type is 
preset for the map to have 384 samples. This does not include 
any blanking, controls, or standards. (Selecting 6-, 12-, 24-, 48-, 
or 96-well geometries enables data reduction capabilities.) 

 

 The ELx800 has 55 “open” assays and Panel assay 99 available.  

 If you are creating/editing a PANEL assay (#99), see page 56 for 
special instructions. 

Create a New Assay 

Select DEFINE at the Main Menu and enter the number of an unused or unneeded 
assay (or press the Options key until it appears). Use the keypad to assign a unique 
name (see the next page). Follow the instructions for each of the parameter categories 
shown above to define the assay parameters. 

Edit an Existing Assay 

Select DEFINE at the Main Menu and enter the number of the assay you wish to edit 
(or press the Options key until it appears). Use the keypad to edit the name, if 
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necessary (see below). Follow the instructions for each of the parameter categories 
shown above to edit the assay parameters. 

How to Name an Assay 

NAME: ASSAY 34 

- % & _ 
 
At the NAME screen when you are creating or editing an assay, you can enter up to 16 
alphanumeric characters. Each assay must have a unique name. 

• Press Shift + the number key for A–H, or scroll through the alphabet with 
the Options key for A–Z. 

• Press Shift + Options to reverse direction.   

• Use the arrow keys ◄ ► on either side of the Options key to move the 
cursor within the display.  

• To add one of the four symbols (- % & _) in the display to the protocol 
name, press its Soft-key. 

• Press Enter when you are finished to store the protocol name. 

Programming Note 

Assays with certain criteria may “lock up” during the Calculating Results… phase 
of data reduction (see Beginning the Plate Read on page 60). This can be corrected by 
modifying assay criteria as follows: 

• Specify at least one (01) sample when mapping the plate, and/or change 
Prompt Sample Count to YES. 

• Set Curve Fit to NONE if the assay does not use a standard curve. 

1. From the Main Menu, select DEFINE. Select the desired assay and then select 
MAP. Press Enter until Enter Number of Samples is displayed. Define at least 
one sample. The software will lock up if zero (00) samples are selected.  

2. From the Main Menu, select  UTIL > READ, and press Enter until Prompt 
Sample Count is displayed. Select YES. 

3. From the Main Menu, select DEFINE > SELECT ASSAY NUMBER: > NAME > 
ENTER. At the DEFINE menu, select CURVE to display Curve-Fit Type and 
select NONE. 
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Define (Method, Map, Formula, Curve) 

DEFINE  METHOD 

METHOD assay parameters include single or dual wavelength, wavelengths (filters), 
and plate geometry. 

At the DEFINE options screen, select METHOD to begin. Assay parameter screens 
appear in the order that they were defined in the assay. If the assay has a closed 
variable (i.e., an element of the assay definition that you cannot access or modify), the 
screen for this variable is not displayed. 

D E F I N E :                    

M E T H O D   M A P  F O R M U L A  C U R V E 

Single or Dual Wavelength 

1. Select METHOD and then select SINGLE or DUAL wavelength.  

2. Press Enter to continue. The Wavelength selection screen allows you to 
select SINGLE or DUAL wavelength for the assay:  

• Single measures the optical density of each well with a single filter. 

• Dual wavelength reads each well twice, each time with a different filter. 
Dual-wavelength readings can significantly reduce optical interference 
caused by scratched or dirty microplates. The microplate carrier does 
not exit the reading chamber between the two measurements. The final 
reported optical density is the difference between the two readings: 
measuring wavelength - reference wavelength = delta OD. 

M E A S : 4 5 0  R E F : 6 3 0           

4 0 5      4 5 0    4 9 0     6 3 0  

3. Select the measurement wavelength. 

4. If applicable, press the right arrow key to move the cursor to REF and then 
select the reference wavelength. 

5. Press Enter to move to the next screen. 
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Plate Type 

For 6- to 384-well standard plates, the plate types and sizes included in the ELx800 
software are based on the brands listed below. For best measurement results, use 
these brands when operating the ELx800 via its onboard software. 

 
Plate Type Brand 

6-well Costar 

12-well Corning 

24-well Corning 

48-well Costar 

96-well Costar 

384-well* Nunc square 

96 T* Terasaki 

72 T* Terasaki 

60 T* Terasaki 
 

*Used only on ELx800NB models 

The Plate Type selection screen allows you to select the geometry of the plate that 
will be used for the assay. Press *MORE to cycle through the available options. 

    6:   6-well (2 x 3) 96: 96-well (8 x 12) 
  12: 12-well (3 x 4) 96H: 96-well Hellma Quartz (8 x 12) 
  24: 24-well (4 x 6) 96M:  96-well Metric (8 x 12, 9 mm well 
  48: 48-well (6 x 8)  spacing) 
 

 “NB” models include choices for 384-well, or 72- and 96-well Terasaki 
plate formats. An adapter (PN 7330531) is available from BioTek if 
Terasaki plates are to be used. 

 

ELx800 Operator’s Manual 



34  | Chapter 3: Operation 
 

DEFINE  MAP 

MAP assay parameters include the following: 

• Automatic or manual map 
generation 

• Mapping direction 
• Replication direction 
• Blank map selection 
• Blanking constant  
• Number of blanks 
• Location of blanks 
• Number of standards 
• Number of standard 

replicates 

• Averaging of standards 
• Concentration and location of 

standards 
• Number of controls 
• Control type definition 
• Number of control replicates 
• Control location 
• Number of samples 
• Number of sample replicates 
• Sample location 

 
At the DEFINE options screen, select MAP to begin the plate mapping process. Assay 
parameter screens appear in the order that they were defined in the assay. If the assay 
has a closed variable (i.e., an element of the assay definition that you cannot access or 
modify), the screen for this variable is not displayed. 

D E F I N E :                    

M E T H O D   M A P  F O R M U L A  C U R V E 

Map Generation 

Select the method by which blanks, controls, standards, and/or samples are 
assigned to specific locations on the plate.  

M A P  G E N E R A T I O N :  M A N U A L     

A U T O   M A N U A L              

• Select AUTO to instruct the software to automatically generate a plate 
map after the blanks, controls, standards, and/or samples have been 
defined. 

• Select MANUAL to indicate that the well assignments will be 
performed manually (by the user) at Define and/or Read time. 

• Press Enter to save the selection and continue. 

 Press SHIFT+CLEAR to remove a previously defined manual map. 
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Mapping Direction 

Specify how the blank, control, standard, or sample groups will be mapped on the 
plate. The well types can be listed in column format (down) or in row format 
(across).  

M A P P I N G    D I R E C T I O N : D O W N     

D O W N   A C R O S S              

• Select DOWN to map down the column. 

• Select ACROSS to map across the row. 

• Press Enter to save the selection and continue. 

Replicate Direction  

Specify how replicates are mapped on the plate. 

R E P   D I R E C T I O N : A C R O S S         

D O W N   A C R O S S              

• Select DOWN to map the replicates down the column, following the 
direction of the map listing. 

• Select ACROSS to map the replicates across (in a paired format). As an 
example, two replicates can be placed in A1 and A2 wells. The third 
replicate would follow in B1. The next standard control, or sample, 
would follow in B2. 

• Press Enter to save the selection and continue. 
 

Example: Map Direction DOWN, Rep Direction DOWN: 

 1 2 3 4 5 6 7 8 9 10 11 12 
A STD1 STD5 SMP          
B STD1 STD5 SMP          
C STD2 PC SMP          
D STD2 PC           
E STD3 NC           
F STD3 NC           
G STD4 SMP           
H STD4 SMP           

Example: Map Direction ACROSS, Rep Direction ACROSS: 

 1 2 3 4 5 6 7 8 9 10 11 12 
A STD1 STD1 STD2 STD2 STD3 STD3 STD4 STD4 STD5 STD5 PC PC 
B NC NC SMP SMP SMP SMP SMP SMP     
C             
D             
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Example: Map Direction DOWN, Rep Direction ACROSS: 

 1 2 3 4 5 6 7 8 9 10 11 12 
A STD1 STD1           
B STD2 STD2           
C STD3 STD3           
D STD4 STD4           
E STD5 STD5           
F PC PC           
G NC NC           
H SMP SMP           

Example: Map Direction ACROSS, Rep Direction DOWN: 

 1 2 3 4 5 6 7 8 9 10 11 12 
A STD1 STD2 STD3 STD4 STD5 PC NC SMP SMP    
B STD1 STD2 STD3 STD4 STD5 PC NC SMP SMP    
C             
D             

 

Start Mapping at Well Location 

This screen appears if automatic mapping is selected. Enter the location of the 
starting well for automatic mapping.  

S T A R T  M A P P I N G                

A T  W E L L  L O C A T I O N : A 0 1     

• Use the numeric and alpha keys to enter a letter or number at the 
cursor location. For any well location, only the alpha keys are active for 
the first character and numeric for the second and third characters. The 
valid entry range is from A01 to the last well on the plate, depending on 
the plate type and the number of blanks, standards, controls, and/or 
samples defined in the assay. 

• Press Enter to save the well location and continue. 

Blank Map 

Select which blanking method to apply to the assay.  

• The available blanking methods are displayed on three screens (select 
*MORE to see additional methods): 

B L A N K   M A P :       F U L L           

 A I R      F U L L   C O N S T  * M O R E 
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B L A N K   M A P :       F U L L           

 R O W     C O L U M N               * M O R E 

 
B L A N K   M A P :       F U L L           

  P - A C R O S S    P - D O W N  *  M O R E 

• Select the Blank Map method (see the descriptions below). 

• Select *MORE to cycle through the available options: ROW or 
COLUMN, and P-ACROSS or P-DOWN. 

• Press Enter to save the method and continue. 

Blank Map Methods 

• AIR performs an initial reading on “air” just prior to the plate read, and 
uses that value as the blank value. This value is subtracted from each well 
on the plate. 

• FULL enables a single blank well or an average of blank wells to be 
subtracted from the whole plate. 

• CONST (Constant) allows entry of a user-specified absorbance value. This 
value will be subtracted from each well on the plate.  

 Tip for using CONST: Use a blank value from the first plate, or a 
blanking plate, to save space on subsequent assay plates. 

• ROW enables a single blank well or an average of blank wells to be selected 
for each row. The maximum number of blanks is 48. The blank (or average) 
will be subtracted from each well in the row. Use manual mapping to 
position blanks, controls, standards, and samples. 

• COLUMN enables a single blank well or an average of blank wells to be 
placed in each column. Since the maximum number of blanks is 12, and if 
all 12 columns are used, each column can have only one blank. Manual 
mapping is recommended in this case. Replicates follow in the same 
column as the first well of each sample, even if the ACROSS direction has 
been specified for replicates. 

• P-ACROSS enables a blank in every even-numbered column to be 
subtracted from the well to the left of it in every odd column. Manual 
mapping is recommended to set up the appropriate map by placing the 
standards, controls, and samples in only the odd columns. 

• P-DOWN enables a blank in the B, D, F, and H rows to be subtracted from 
the well above in the A, C, E, and G rows. Manual mapping is 
recommended to set up the appropriate map by placing the standards, 
controls, and samples in only the A, C, E, and G rows. 
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Constant Blank Value 

This screen appears if the Constant blank map method is selected. Enter the value 
to be subtracted from each well on the plate. 

E N T E R                               

B L A N K I N G  C O N S T A N T :  1 . 2 0 0 

• Use the numeric keys to enter the value. The range is 0.000 to 3.000. 
The cursor is positioned at the first editable field and advances 
automatically. 

• Press CLEAR to clear the value on the display.  

• Press Enter to continue. 

Number of Blanks 

This screen appears when the Full, Column, or Row blank map method is 
selected. Enter the number of blank wells in the assay.  

E N T E R  N U M B E R  O F          

B L A N K S :                0 2 

• Use the numeric keys to enter the number of blanks, 0 to 48. 

• Press CLEAR to clear the value on the display.  

• Press Enter to continue. 

Blank Location  

This screen appears if manual mapping was selected. Define where the blank well 
or wells occur on the microplate.  

E N T E R   T H E   L O C A T I O N   O F       

B L A N K #  1 :                       A 1 2 

• Use the numeric and alpha keys to enter a Blank Location, based upon 
the plate geometry.  

• Use the arrow keys to move the cursor to the next or previous editable 
field. The cursor is positioned beneath the first editable field. 

• Press Enter to continue. 
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Number of Standards 

Enter the number of standard groups that will be used in the assay. If the number 
of standards is changed, the number of replicates for the standard automatically 
resets to 01.  

E N T E R   N U M B E R  O F                   

S T A N D A R D S :              0  2 

• Use the numeric keys to enter the number of standards. The valid 
range depends on the selected curve fit method. The maximum number 
of standards is 12. The minimum is 4 for 4-P fit, cubic, cubic spline, and 
logit-log; 3 for quadratic; and 2 for linear and point-to-point. 

• Press Clear to clear the value on the display. 

• Press Enter to continue. 

Number of Standard Replicates 

Enter the number of replicates per standard group in the assay.  

E N T E R   N U M B E R   O  F                   

S T A N D A R D  R E P L I C A T E S :   0 2 

• Use the numeric keys to enter the number of standard replicates, from 
1 to 8. The software will verify that the number of replicates, multiplied 
by the number of standards, does not exceed the number of wells on the 
plate. 

• Press Clear to clear the value on the display. 

• Press Enter to continue. 

Average Standards 

Select whether or not to calculate the average of the replicates of each standard 
group. This option is not available if the number of standard replicates is 01. 

A V E R A G E   S T A N D A R D S ?   Y E S      

   Y E S         N O                             

• Select YES to average the replicates for each standard group, and then 
use the group averages when calculating the standard curve.  

• Select NO to use the individual standard replicates when calculating the 
standard curve. 

• Press Enter to continue. 
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Standard Concentrations 

Enter the predicted or expected concentration value for each standard group. If 
manual mapping was selected, the replicate locations must also be defined. 

C O N C N   O F             L O C A T I O N    

 S T D 1 : 0            R E P #  1 : A 0 1 

• Use the numeric and alpha keys and the decimal point key to enter 
standard concentration values. The range is 0.00001 to 999999. The entry 
cannot exceed six characters including the decimal point.  

• If automatic mapping is selected, each replicate’s location is available 
for viewing only. Pressing Enter advances to the concentration value 
entry for the next standard. 

• If manual mapping is selected, the location must be defined. Pressing 
Enter from the standard concentration entry moves the cursor to the 
Location field. Pressing Enter from the Location field advances to the 
concentration value entry for the next standard. 

   Valid Well Locations 

When defining the replicate locations, only the alpha keys are active for the 
first character and numeric for the second and third characters. Valid 
characters and numeric entries are based on the selected plate geometry.  

Acceptable entries for well locations based on plate geometry: 

 

Plate Type Range 

6-Well A01-B03 

12-Well A01-C04 

24-Well A01-D06 

48-Well A01-F08 

96-Well A01-H12 

96H A01-H12 

96M A01-H12 
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Reuse of Standard Curves 

The ELx800 has the ability to reuse a standard curve that has already been 
established. 

Limitations: 

• Standard curves can only be reused in assay positions 32 through 55. Each 
of these positions can only store one standard curve. 

• Standard curves cannot be reused on panels (see page 56). 

• Standard curves will be stored in memory with the Assay Name, Standard 
Concentrations, Replicate Counts, and Optical Density values for each 
standard replicate. 

• Stored standard curves can only be reused for the assay that the curve was 
originally generated on (e.g., the curve for Assay 53 cannot be applied to 
samples on a plate to be run in Assay 51). 

• To reuse a standard curve, you must first program an assay (in positions 32 
through 55) and then run the assay. During the defining process, you will 
be prompted to enter the number of standards, the number of standard 
replicates, and the standard concentrations. The following screen will 
appear after these prompts: 

R E U S E   S T A N D A R D   C U R V E ?  Y E S 

 Y E S      N O                               

After the assay has been run, the results have been calculated, and the reports 
have been generated, the reader will prompt if this standard curve should be 
stored in memory. The following display will appear: 

S A V E   S T A N D A R D   C U R V E ?   Y E S 

 Y E S       N O                               

Select YES to store the curve for use at a later time. The next time a plate is to 
be read using this assay,  the instrument will prompt if there are standards on 
the plate. Select NO to discard the curve.  

S T A N D A R D S   O N   P L A T E  ?     N O   

Y E S   N O                                     

• If YES is chosen, a new standard curve will be generated.  The plate map is 
not changed. (If “Prompt for Sample ID” is enabled in the UTIL section, 
you will be prompted to enter the number of samples. See page 66 for more 
information.) 

• If NO is chosen, the stored standard curve will be used. If auto mapping 
had been used to originally map the standards, blanks, controls and 
samples defined for this assay, the map will be automatically regenerated 
without the standards, beginning in well xxx (where xxx was chosen as the 
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starting well in the map, usually well A01). If manual mapping was used 
to map the plate, the map is not regenerated—the reader will not produce 
results for the well positions that originally were standards. Auto mapping 
is recommended, if the standard’s curves will be routinely reused. 

Number of Controls 

Enter the number of control groups that will be used in the assay.  

E N T E R   N  U M B E R   O F                   

C O N T R O L S :                 0  2  

• Use the numeric keys to enter the number of control groups in the 
assay. For example, if the assay requires one or more positive control 
wells and one or more negative control wells, enter 02. 

• The valid entry range depends on the number of locations on the plate 
that are undefined. The maximum number of control groups is 8. 

Control Identifiers 

Select an identifier for each control group used in the assay.  

C O N T R O L #  1 :                P C       

     P C         N C     H P C        * M O R E 

 
C O N T R O L #  1 :                P C       

 L P C      C T L 1       C T L 2  * M O R E 

 
C O N T R O L #  1 :         P C    

 C T L 3   C T L 4         * M O R E 

• Choose one control identifier for each type of control in your assay. The 
available options are: Positive Control, Negative Control, High Positive 
Control, Low Positive Control, CTL1, CTL2, CTL3, CTL4. 

• After choosing an identifier for Control #1, press Enter to choose the 
identifier for the next control. 
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Number of Control Replicates 

Enter the number of replicates for each control group. 

E N T E R  N U M B E R   O  F                   

R  E P L I C A T E S  O F   P C :            0  2 

• The well ID associated with Control #1 appears first. Press Enter to 
advance to the next control. 

• Use the numeric keys to enter a value for the number of replicates. 

• The valid entry range is from 1 to 12 replicates. The software 
automatically performs a check to ensure the number of replicates, 
multiplied by the number of controls, does not exceed the number of 
undefined wells remaining on the plate. 

Location of Controls 

Enter the location of controls in the assay. 

C O N T R O L # 1             L O C A T I O N   

T  Y P E : P C                 R E P # 1 : A 0 2  

 
 The location can only be edited if manual mapping was selected 

(see page 34). 

• Use the numeric and alpha keys to enter the well location for Rep #1 
of Sample Group #1. Press Enter to advance to the next replicate or 
sample group. 

Number of Samples 

(Optional) Enter the number of sample groups on the plate. This information can 
also be entered at run-time (see Selecting Read Options on page 66). 

E N T E R   N U M B E R   O F                   

S A M P L E S :                  2 4 

• Use the numeric keys to enter the number of sample groups on the 
plate. The range is 0 to the number of undefined well locations 
remaining on the plate. For example, if there are no controls, blanks, or 
standards defined on a 96-well plate, the maximum number of samples 
is 96, and the minimum number of samples is 1. 

ELx800 Operator’s Manual 



44  | Chapter 3: Operation 
 

Number of Sample Replicates 

Enter the number of replicates for each sample group. 

E N T E R   N U M B E R   O F                   

S A M P L E   R E P L I C A T E S :      0 2 

• Use the numeric keys to enter the number of sample replicates.  

• The valid range is from 1 to 12 replicates. The software automatically 
performs a check to ensure that the number of replicates multiplied by 
the number of samples does not exceed the number of undefined wells 
remaining on the plate. 

Sample Location 

If manual map generation was selected and samples are defined, specify the 
location for each sample replicate. 

S A M P L E   # 1        L O C A T I O N    

                        R E P #  1 : C 0 2 

• Use the numeric and alpha keys to enter the well location for Rep #1 
of Sample Group #1. Press Enter to advance to the next replicate or 
sample group. 

 

DEFINE  FORMULA 

The ELx800 supports three types of formulas (Cutoff, Transformation, and Validation), 
as well as the ability to define variables for use within formulas. Up to three types of 
Validation formulas may be defined (Blank, Control, and Assay Validation). 

At the DEFINE options screen, select FORMULA. The Select Formula Type screen will 
appear (described on the next page). 

D E F I N E :                    

M E T H O D   M A P  F O R M U L A  C U R V E 

Calculation Structure 

During data reduction, formulas are processed in the order shown below. The 
number of permitted formulas of each type is shown as well. 

• Blank Validation  0-1 

• Control Validation  0-4 

• Assay Validation  0-4 
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• Transformations  0-1 

• Cutoff Formulas  0-1 

• Curve-Fit Analysis (if a curve-fit method is defined) 
 

 

 

L 
When used in standalone mode, the ELx800NB does not 
have access to data reduction options for 384-well plates. 
To capture and manipulate the raw data, you must use 
Gen5 software. See Getting Started with Gen 5 on 
page 27 for more information. 

Formula Type 

The ELx800 supports three types of formulas, as well as the ability to define 
variables for use within Transformation formulas.  

 GENERAL formulas are not used. 

S E L E C T   F O R M U L A   T Y P E :         

C U T O F F   T R A N S   V A L     * M O R E 

 
S E L E C T   F O R M U L A   T Y P E :         

G E N E R A L   T R A N S - V A R   * M O R E 

• CUTOFF formulas are used to classify results. During data reduction, 
results are evaluated against the cutoff formulas, and each well is 
assigned a user-specified label (POS, NEG, or EQUIV). 

• TRANSformation formulas are applied to the raw data in preparation 
for further data reduction and/or curve fit calculation. 

• VALidation formulas can be used to determine whether or not blanks 
and/or controls are valid. In addition, Assay Validation formulas can 
be used to determine whether or not the entire assay should be 
considered valid. 

• The TRANS-VAR option allows you to define a variable to be used in 
transformation formulas. 

Formula Entry 

After the formula type is selected, a formula entry screen appears. Each formula 
can contain a maximum of 24 characters. Spaces are not necessary. 

 In formulas, “OD” is used to represent the optical density value. 
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F O R M U L A # 1 :                             

  M A T H   O T H E R     M A P     F U N C T N 

 
P C ; X > 1 . 2 0 0                             

  M A T H   O T H E R     M A P     F U N C T N 

• After a moment, the Formula #1 prompt disappears, and the formula 
can be entered. Use the options found under Math, Other, Map, and 
Functn to “build” the formula.  

 To cycle through the available Math, Other, Map, and Functn 
options, continue to press the appropriate soft key. For example, 
press the Math soft key several times to see +, -, *, /, %, =, and so 
on. When the desired option appears, press the right arrow key to 
select it and advance to the next editable field.  

 Press the left arrow key to move the cursor to the left. 

 Press Clear to delete the item above the cursor. 

 When a formula is complete, press Enter to continue. 

• Select MATH to insert a mathematical symbol such as +, %, or <=. 

• Select OTHER to insert an opening or closing parenthesis “(“ or “)”, or 
logical operators AND or OR. 

• Select MAP to insert a well ID such as BLK;x or NC;1. 

• Select FUNCTN to insert a mathematical function such as LOG or SQRT. 
 

L The reader software checks the formulas for errors 
during data reduction. A syntax error in a formula will 
result in a “Token Error” message on results reports. 
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MATH 

The following mathematical symbols can be used in formulas: 
 

+ Addition  == Equal to 

- Subtraction  > Greater than 

* Multiplication  >= Greater than or equal to 

/ Division  < Less than 

% Percent  <= Less than or equal to 

OTHER 

The following additional symbols can be used in formulas: 
 

( Left parenthesis 

) Right parenthesis 

AND Logical AND 

OR Logical OR 

MAP 

The available MAP options depend on the formula type and the current plate map. 
MAP options resemble BLK;x (mean of the blank wells), NC;1 (the first NC well), 
or OD (every well). 

FUNCTION 

The following functions can be used in formulas: 
   

LOG10 Log Base 10  ALOG Anti Log 

ALOG10 Anti Log Base 10  LOG Log 

AB Absolute Value  SQRT Square Root 

PWR Power    

Examples 

Log10 2 = 0.301029995 ALOG (0.69314718) = 2 

ALOG10 (0.30102995) = 2 LOG 2 = 0.69314718 

AB (-1) = 1 SQRT 2 = 1.4142 

(10 PWR 2) = 100  
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Validation Formulas 

Validation formulas can be used to determine whether or not blanks and/or 
controls are valid. In addition, Assay Validation formulas can be used to 
determine whether or not the entire assay should be considered valid. 

See Formula Type on page 45 for instructions on selecting an assay and accessing 
the Select Validation Type screen. 

S E L E C T   V A L I D A T I O N   T Y P E :   

C O N T R O L           A S S A Y    B L A N K 

Control and Blank Validation Formulas 

Blank Validation is used to ensure that the OD values for the blank replicates, 
or for the blank mean, meet certain criteria. Control Validation serves the same 
purpose as Blank Validation, but it applies to the control replicates or control 
mean. If the criteria are not met, results are considered suspect, and the 
message “RESULTS INVALID! BLANK (OR CONTROL) VALIDATION 
FAILED” appears on results reports. 

• One blank validation formula can be defined. 

• Up to four control validation formulas can be defined. 

• Define the plate map (via DEFINE > MAP) before creating blank or 
control validation formulas. 

• Blank/Control validation can be performed on individual replicates 
(BLK, PC), or on the group mean (BLK;x, NC;x). 

Examples 

If an assay protocol states that 

• Each blank well on a plate should have an OD of less than 0.050, the 
formula is: BLK < 0.050 

• Each Positive Control replicate must have an OD higher than 1.000, but 
less than 2.500, this can be accomplished with one formula:  
PC > 1.000ANDPC < 2.500  
Or with two separate formulas: PC > 1.000 and PC < 2.500 

• Negative Control mean must have an OD of less than 0.100, the formula 
is: NC;x < 0.100 

Number of Required Controls/Blanks 

If a control or blank validation formula is defined, enter the number of valid 
controls or blanks that must meet the criteria established by that formula. 
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P C :  N U M B E R  O F  V A L I D           

R E P L I C A T E S  R E Q U I R E D :     0 2 

• Use the numeric keys to enter the number of valid controls required. 
The range is 1 through the number of defined replicates of a control or 
blank.  

• Press the Clear key to clear the displayed value. 

• Press Enter to save the displayed value and advance to the next screen, 
or use the Previous Screen key to move backward through the menu 
structure. 

Assay Validation Formulas 

Assay Validation formula(s) establish a set of criteria used to determine 
whether or not an assay can be considered valid. If the criteria are not met, 
results are considered suspect, and the message “RESULTS INVALID! Assay 
validation failed” appears on results reports. 

• Up to 4 assay validation formulas can be defined. 

• Define the plate map (via DEFINE > MAP) before creating assay 
validation formulas. 

Examples 

If an assay protocol states that for the assay to be valid: 

• The mean of the negative controls must be less than 0.100. The formula 
is: NC;x<0.100 

• The mean of the positive controls must be greater than the mean of the 
negative controls. The formula is: PC;x>NC;x 

Transformation Formulas 

Transformation formulas can be used to transform raw or blanked absorbance data 
in preparation for further data reduction, including curve-fit analysis. 

See Formula Type on page 45 for instructions on selecting an assay and accessing 
the Transformation Formula definition screen. 

• If a blanking method is selected in the assay, transformation formulas are 
applied to the blanked absorbance values; otherwise, they are applied to 
the raw data. Turn to page 44 to review the results calculation structure. 

• One transformation formula may be defined per assay. 

• A transformation formula can be simple (ex. (OD/2)*100 to multiply all 
wells on the plate by 100), or more complex with the inclusion of a 
predefined Transformation Variable (see TVAR, below). 
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Simple Transformation Formulas 

“Simple” transformation formulas are typically applied to all wells on the 
plate. For example: 

• To divide the OD in each well on the plate by 2 and then multiply by 
100, the formula is:  (OD/2)*100 

Transformation Variable (TVAR) 

For more complex transformations, a Transformation Variable (TVAR) can be 
defined for use within a transformation formula. This variable defines the 
scope of the transformation: whether to apply the transformation to all of the 
wells on the plate (OD), or just to the sample wells (SMP). 

S C O P E  V A R I A B L E :           O D 

 S M P    O D                

• If SMP is chosen: 

The transformation formula will be applied to the sample wells only.  

SMP and any other well identifiers (BLK, PC, NC, STD, etc.) defined 
will become available as MAP options when building the 
transformation formula. 

Example: The assay plate map contains 2 NC wells and 2 PC wells. The 
remainder of the map is filled with samples. The assay data reduction 
requires that the mean of the NC be subtracted from all the samples on 
the plate. The transformation formula is:  SMP-NC;x 

• If OD is chosen: 

The formula definition screen will appear so that you can define a 
formula for use within the transformation formula. 

Use the formula keys (Math, Other, Map and Function) to define the 
Transformation Variable (TVAR). Once the variable has been defined, it 
can be used in a transformation formula. The TVAR will be available as 
a MAP option when building the transformation formula. 

Example: 

The assay plate map has 2 blanks, 1 control well in duplicate (CTL1), 1 
negative control well in triplicate (NC), and 5 standards in duplicate 
(STD1-STD5). The assay data reduction states:  

Subtract the mean of CTL1 from the mean of the NC. Subtract the 
difference from all ODs on the plate. 

Divide the result of the above by the mean of the NC less the mean 
of CTL1, and then multiply by 100.  

On paper, the formula reads:  
(OD-(NC;x-CTL1;x))/(NC;x-CTL1;x)*100 
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On the reader, the formula (NC;x-CTL1;x) will be programmed as the 
TVAR, since the transformation will apply to all standards, controls, 
and samples on the plate. 

1. At the SCOPE VARIABLE selection screen, choose OD and press Enter.  

2. Enter the formula (NC;x-CTL1;x) by using the MATH, OTHER, 
MAP and FUNCTION keys. Press Enter. 

3. The formula definition screen is displayed. Choose TRANS. 

4. Enter the formula (OD-(TVAR)/(TVAR)*100) using the MATH, 
OTHER, MAP, and FUNCTION keys. (“TVAR” is a MAP option.) 

Example: 

In the case of competitive reactions, converting absorbance data to 
percent B/B0 can be: (OD/STD1)*100. This divides all the wells by 
STD1,presumably the 0 standard, and multiplies the results by 100. To 
do this: 

1. At the SCOPE VARIABLE selection screen, choose OD and press 
Enter. 

2. Enter STD1 as the TVAR formula. Press Enter. 

3. The formula selection screen is displayed. Choose TRANS. 

4. Enter the formula (OD/TVAR)*100 using the  MATH, OTHER, 
MAP, and FUNCTION keys. “TVAR” is a MAP option. 

Cutoff Formulas 

A cutoff formula calculates a cutoff value that is used for classifying samples. See 
Formula Type on page 45 for instructions on selecting an assay and accessing the 
Cutoff formula definition screen.  

During data reduction, results are evaluated against the cutoff value (with an 
optional greyzone), and each well is assigned a call POS (positive), NEG 
(negative), or EQUIV (equivocal). 

• One cutoff formula may be defined per assay. 

• If Transformation Formulas are defined, cutoffs are based on the 
transformed results. Refer to “Defining Formula” on page 44 for the 
order in which formulas are processed.  

• A cutoff formula can consist of a simple numeric value (1.500); a well 
identifier (PC to indicate the criterion for each of the PC replicates, or 
PC;x to indicate the average of the Positive Control replicates); or a 
formula combining the two (NC;x+0.050). 

• A “greyzone” around the cutoff value can be defined, to indicate 
equivocal or indeterminate results. 

• Do not use the < or > mathematical symbols in a cutoff formula. 
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 Tip: Choose to print a Column Report to see the greyzone and cutoff 
values as well as the equations used to assign calls to samples. 

Greyzone Entry 

The greyzone is a definable area around the cutoff value. Samples that fall 
within an area defined by the greyzone (ex. ± 5.0% of the cutoff value) could be 
considered equivocal (EQUIV). 

E N T E R   G R E Y Z O N E :           0  5 % 

                                               

• Use the numeric keys to enter the greyzone percentage. 

• The valid entry range is from 00 to 99%. An entry of 00% indicates no 
greyzone, although a sample equal to the cutoff value will still receive 
the EQUIV call. 

• See the next section for information on how calls are assigned. 

Positive / Negative Calls for Cutoff 

After the greyzone is defined, calls for the sample wells (POSitive, NEGative, 
EQUIVocal) must be defined. 

S A M P L E > C  U T O  F  F  +  0 5 % :       P  O  S  

 P O S     N E G                    

• Select POS or NEG to select the call that will be assigned to samples 
greater than the cutoff value plus the greyzone. 

• If, for example, POS is selected as shown in the above screen, calls will 
be assigned according to the following equations (SMP represents the 
sample wells): 

EQUIV: SMP <= (CUTOFF+(CUTOFF*GREYZONE)) and 
  SMP >= (CUTOFF-(CUTOFF*GREYZONE)) 

POS: SMP >  (CUTOFF+(CUTOFF*GREYZONE)) 

NEG: SMP <  (CUTOFF-(CUTOFF*GREYZONE)) 

Example: 

The cutoff between negative and positive calls should be calculated as the 
average of the negative controls plus the OD value of 0.500. Samples greater 
than the cutoff should be labeled as positive. No greyzone is required. 

• For this example, NC;x (the mean of the NC wells) equals 1.000 OD 

• The cutoff formula is NC;x+0.5 

• The greyzone is 00% 
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• POS is selected for SAMP>CUTOFF+00% 

• Calls are assigned to sample wells as follows: 

 EQUIV if the sample equals 1.500 

 POS if the sample is greater than 1.500 

 NEG if the sample is less than 1.500 

Example: 

For a quantitative assay, samples with OD values greater than the STD2 mean 
plus a 10% greyzone should be labeled as positive; samples with OD values 
less than the STD2 mean minus the 10% greyzone should be labeled as 
negative. All other samples should be considered equivocal. 

• For this example, STD2;x (the mean of the STD2 wells) equals 2.000 OD 

• The cutoff formula is simply STD2;x 

• The greyzone is 10% 

• POS is selected for SAMP>CUTOFF+10% 

• Calls are assigned to sample wells as follows: 

 EQUIV if the sample is greater than or equal to 1.800 and  
less than or equal to 2.200 

 POS if the sample is greater than 2.200 

 NEG if the sample is less than 1.800 

DEFINE  CURVE 

CURVE assay parameters include curve fit type, editing of outliers, axis identification, 
and extrapolation of unknowns. 

At the DEFINE options screen, select CURVE. Assay parameter screens appear in the 
order that they were defined in the assay. If the assay has a closed variable (i.e., an 
element of the assay definition that you cannot access or modify), the screen for this 
variable is not displayed. 

D E F I N E :                    

M E T H O D   M A P  F O R M U L A  C U R V E 
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Curve-Fit Type 

The ELx800 supports several curve-fitting methods.  

C U R V E - F I T   T Y P E :   L I N E A R   

 N O N E   L I N E A R   Q U A D     * M O R E 

 
C U R V E - F I T   T Y P E :   C - S P L I N E 

 C U B I C     4 - P      2 - P    * M O R E 

 
C U R V E - F I T   T Y P E :   C - S P L I N E 

  C - S P L I N E      P T - P T  * M O R E 

• LINEAR: A simple best-fit straight line is plotted using the values of the 
standards. 

• QUAD (Quadratic): A curve fit that uses the quadratic equation “ax2 +bx 
+c = y” to plot the standard’s values. Utilizing this curve, any data 
point for a standard that deviates from the ideal value will not affect the 
entire curve. 

• CUBIC: A curve fit that uses the equation “ax3 + bx2 + cx + d = y” to 
plot the standard’s values. This type of curve fit is affected even less 
than the quadratic fit when any particular standard has a poor value.  

• 2-P (LOGIT/LOG): A curve fitted to the standard values, which is 
characterized by a skewed sigmoidal (S-shaped) plot that eventually 
becomes asymptotic to the upper and lower standard values. The 
logistic equation is algebraically transformed to a simpler form in which 
experimentally determined values are used for the responses at 
concentrations of zero and infinity. Note: Uses linear axis type only. 

• C-SPLINE (Cubic Spline): A piecewise polynomial approximation 
consisting of joining a set of data points by a series of straight lines, 
which is then smoothed by using a cubic fit. 

• 4-P (4-Parameter Logistic): A curve fitted to the standard values, which 
is characterized by a skewed sigmoidal (S-shaped) plot that becomes 
asymptotic to the upper and lower standard values. The 4 parameters 
are: Left asymptote, Right asymptote, Slope and Value at the Inflection 
point. This fit is most recommended for immunoassay data, and is more 
exact than Logit/Log. Note: Uses linear axis type only. 

• PT-PT (Point to Point): A plot that connects each standard point with a 
line, with no averaging of the values to “smooth” the curve at each 
standard. 
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Edit Standard Outliers 

Choose to enable or suppress the ability to edit standard outliers after the standard 
curve has been calculated. If enabled, the user can exclude one or more standards 
from the recalculation of the curve.  

E D I T   S T D   O U T L I E R S : M A N U A L 

  N O N E   M A N U A L                        

• Select NONE to suppress the ability to edit standard outliers for this 
assay. 

• Select MANUAL to enable the capability.  

 If Average Standards is set to NO, the standard replicates are 
available for editing. If set to YES, the standard groups are 
available for editing. 

 After the assay is run and reports are generated, select REPORT > 
RESULT, select the assay, and then press Enter. The EDIT STD 
OUTLIERS? YES/NO prompt will appear. See Editing Standard 
Outliers on page 62 for further instructions. 

X/Y Axis Type 

Select the X/Y Axis Type.   

X / Y    A X I S   T Y P E :   L I N             

L I N     L I N / L O G   L O G   L O G / L I N 

• Select the method by which the X- and Y-axes will be scaled.  

• This option is not available for the 2-P and 4-P curve-fit types; the X/Y 
scaling for these curves is always LIN/LIN. 

• LIN/LIN axes are recommended when using the Cubic Spline fit. 

Extrapolation of Unknowns 

Specify whether to extrapolate the curve to evaluate samples outside of the 
absorbance range defined by the standards.  

E X T R A P O L A T E   U N K N O W N S ? Y E S 

 Y E S         N O                             

• Select YES to enable extrapolation; otherwise, select NO. 

• On the printed reports, extrapolated concentrations (RSLT values) are 
surrounded by < > (e.g., <44.425>). 
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L If Extrapolate Unknowns is enabled for the Point-to-Point 
curve fit, unknown concentrations will be extrapolated linearly 
from the nearest segment of the curve. If the plot includes both 
increasing and decreasing segments, the curve printout will be 
labeled “Ambiguous.” The resulting values, which actually are 
extrapolated, may not be indicated as such. All calculated 
results for an “Ambiguous” curve should be considered 
unreliable. 

 

Panel Assays 

A Panel assay is a collection of up to 8 assays to be run on one plate. 

• A common reason to use a Panel assay is when one or more samples are 
tested for more than one antigen. An example is an ENA panel which could 
screen dsDNA, Sm, SSA, SSB, Scl-70, and/or Jo-1 on one microplate. 

• Only one panel can be defined on the reader at any time.  

• The assays specified within the Panel must be predefined in any of the 
assay positions 1-55. 

• The assays specified within the Panel must all use the Endpoint read 
method and all read at the same wavelength(s). 

• Any curve-fit type, formulas, or standard concentrations previously 
defined for each assay will be used when the assay is selected for a Panel.   

• Panel assays cannot reuse standard curves. 

• Only an Auto map is recognized by a Panel assay. Custom locations 
entered using a Manual map will be overwritten by the Panel assay. 

• If the Panel runs in a 1*12(ACROSS) configuration both the Map Direction 
and Replication Direction must be set to ACROSS during assay definition. 
ACROSS should then be selected as the direction during Panel definition. 

• The type and number of controls, blanks, standards, and replicates in the 
assays chosen for the Panel will be “copied” into the Panel definition. Map 
or assay parameters must first be changed in the predefined assay before 
they can change in the Panel. 

 
To create a panel assay: 

1. Start at the Main Menu, select DEFINE and choose assay number 99.  

2. The default assay name is “PANEL”. Use the alpha and numeric keys to 
update the assay name, if desired. 
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N A M E :      P A N E L                  

 -       /        :     S P A C E 

3. Press Enter to continue. The Number of Assays screen appears. 

N U M B E R   O F    A S S A Y S :             2 

                          

4. Specify the number of assays to include in the panel (1 to 8). 

5. Press Enter to continue. The Mapping Direction screen appears. This option 
ensures that all assays will be mapped in the same direction. 

M A P P I N G   D I R E C T I O N : D O W N     

D O W N   A C R O S S              

6. Select DOWN or ACROSS. 

7. After selecting the mapping direction of the assays, choose which assays to 
include in the panel. Press Options to cycle through the assay numbers and 
names, or use the numeric keys to enter an assay number. Press Enter to 
make a selection. 

S E L E C T   A S S A Y    N U M B E R :      2 2 

N A M E :  H B S - A G 1            

8. After an assay is selected, define its starting location. Use the alpha and 
numeric keys to choose the well location to begin the assay. 

S T A R T    M A P P I N G                        

A T   W E L L   L O C A T I O N :     A 0 1 

9. Repeat this process for each assay within the panel. Remain aware of the total 
number of controls, standards, and blanks that were originally mapped in 
each assay while mapping for the panel assay.  

 For example, to include Assays 1, 8, and 22 in the Panel assay (DOWN 
mapping is selected for the Panel): 

 Assay 1 has a total of 12 wells defined for controls, blanks, and 
standards. In the Panel, the mapping for Assay 1 begins in well A01. 
The user wants to run 6 samples in Assay 1. Assay 1 now fills wells 
A01 through B03. 

 The mapping for Assay 8 can begin in well B04, or any well other 
than A01 to B03. The reader will “beep” if you try to map into a well 
that is already assigned for use with the Panel.  

 The mapping for Assay 22 may begin at the next available well 
location after Assay 8 mapping is complete.   
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 The Panel Assay results are sorted by sample (unless a custom assay 
has been programmed by BioTek).  

 The interpretation of Results reports for each assay in the Panel 
will print first, and then the Sample results will print.    

Reading a Microplate 

Press the READ option, found at the Main Menu, to read a microplate. 

• From the MAIN MENU screen, press the soft key beneath the READ menu 
option to access the SELECT ASSAY NUMBER screen. 

• Alternately, press the red READ key on the lower right of the keyboard. 

Select Assay 

At the Select Assay Number screens: 

• Use the NUMERIC keys to enter the number of any predefined Assay 
Definition Files stored in the reader’s memory, or the OPTION key to 
advance one assay at a time. The cursor is positioned at the first editable 
field and advances automatically. The numeric range depends on the 
number of assays programmed in the reader’s memory. 

The assay’s name and number are displayed on the screen.  
 

S E L E C T  A S S A Y   N U M B E R :   6 5 

N A M E : H B S - A G 1               

• Press Enter to advance to the Run-Time prompts. 

• MAIN MENU: Returns the display to the Main Menu screen. 

Run-Time Prompts 

After the assay is selected, one or more informational prompts may be presented, 
depending on preferences selected in UTIL > READ, whether or not the assay 
specifies manual mapping, or if a custom assay database is installed on the reader.   

• Prompts enabled via UTIL > READ can include ENTER NUMBER OF 
SAMPLES, PLATE ID, and ENTER SAMPLE ID. 

• If the assay specifies manual mapping, prompts for information will 
include the locations for the sample wells. 
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• If running a custom assay, typical prompts might include: 

Number of samples 
Standard concentrations 
Assay ID 
Fill pattern 
Blank method 
First well location 
Replicate count for each well type 
Wavelength mode 
Report preferences 

Enter Number of Samples 

If prompted, enter the number of sample groups on the plate. (The number of 
sample replicates is typically predefined in the assay, but if this is a custom assay, 
you may also be prompted to enter the replicate count.)  

E N T E R   N U M B E R   O F           

S A M P L E S :                2 0 

• Use the numeric keys to enter the number of sample groups. 

• The valid entry range is from 01 to the maximum number of wells 
remaining on the plate after any blank, control, or standard wells are 
mapped. 

• If you enter a value greater than the number of empty wells remaining 
on the plate, the reader will “beep” and automatically change the value 
to the maximum permissible number of samples. 

Enter Plate ID 

If prompted, enter a unique plate identifier to be stored in memory with the assay 
name and absorbance data. 

P L A T E   I D :  1 2 3 4 A           

 -          /          :       S P A C E 

• Use up to 10 alphanumeric characters. See page 39 for instructions on 
using the keypad. 

• Press Enter to advance to the Enter Sample ID screen. 

 Use caution when creating multiple Plate IDs. The reader does not 
warn you that you are about to exceed the maximum of 8 plate IDs 
stored in memory. If a ninth Plate ID is added, it will overwrite the 
first Plate ID stored in memory. 
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Enter Sample ID 

If prompted, enter a starting sample identification number.  

E N T E R                      

S A M P L E   I D :   0  0 0 1                

• The valid entry range is from 0001 to 9999.  

• The software will automatically increment each subsequent sample 
identification number by 0001.  

• The sample IDs will be assigned according to the plate map defined in 
the assay. 

Prompts for Well Location 

Well locations can be changed at run time if a Manual Map has been specified, and 
you have requested a sample count at run time via the Utilities menu. 
 

S A M P L E #  1      L O C A T I O N    

                  R E P #  1 : G 0 1 

• Use the KEYBOARD to enter the well location, using the SHIFT-LETTER 
sequence to key in letters, and press Enter to specify the desired location. 

Beginning the Plate Read 

When the following screen appears, the reader is ready to read a plate: 

P L A C E   P L A T E   I N   C A R R I E R    

A N D   P R E S S   < R E A D >  K E Y      

• Place the plate in the carrier and press the READ key to initiate the plate 
read. After the plate has been read, all requested reports will be generated. 

• To halt in read in progress, press the STOP key. 
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Printing Reports and Assay Lists 

L Important! The ‘OUT’ indication on reports means the OD for 
an individual well, or the average OD for a group of wells, falls 
outside the minimum/maximum OD range defined for the assay. 
For the Quick Read assay on the ELx800, this range is –3.0 OD to 
+3.0 OD. For assays defined onboard by a user (Assay 2 – Assay 
55), it is -4.0 OD to +4.0 OD.   

 
Reports are automatically generated after a plate has been read (see Specifying Data 
Output and Reporting Options on page 65 for information on selecting reports). 
Results reports also can be regenerated manually by using the REPORT option from the 
Main Menu. In addition, Map, Assay, and Assay List reports can be printed. 

 See Appendix A for sample reports. 

 
R E A D Y   0 1 : 2 2 P M   0 1 / 2 3 / 0 8 

R E A D   D E F I N E   R E P O R T  U T I L 

 
P R I N T   R E P O R T :                      

R E S U L T    M A P    A S S A Y  L I S T   

• The eight most recent sets of plate data are stored in memory (see next 
page). Select REPORT > RESULT to print an exact copy of results from the 
plate reading.  

 The form in which the results are presented is determined by the report 
settings (Matrix, Column, Curve Fit) specified under UTIL > OUTPUT.  

• Select MAP to print a matrix showing the locations of the Blanks, 
Standards, Controls, and Samples for a particular assay. 

• Select ASSAY to print a plate map and a listing of all of the assay’s settings, 
such as wavelengths, numbers of well types, formulas, and curve-fit 
parameters. 

• Select LIST to print a list of all assays (name and number) currently 
programmed in the reader. 

Results Report 

The reader stores the data for the 8 most recent plate reads. Results reports can be 
generated for these plates if, for example, the data that automatically printed after the 
read needs to be printed in a different format, or if the standard curve contains outliers 
that require editing. 
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R E P O R T : H B S - A G                      

I D :   0 0 1         0 1 / 2 3 / 0 8        

• The most recently read plate is presented first, showing the assay name, the 
plate ID (if one was entered), and the date the plate was read. 

• Press Options to see the next plate in memory. 

• Press Enter to select a plate and continue. 

• If a standard curve was generated and Edit Standard Outliers was set to 
manual in the assay definition, the Edit Standard Outliers? prompt is 
presented; otherwise, the Print Results? prompt is presented. 

Editing Standard Outliers 

If a standard curve was generated and if Edit Standard Outliers was set to MANUAL in 
the assay definition, the option to edit outliers is presented. 

E D I T   S T D   O U T L I E R S :            

  Y E S    N O                              

• Select NO to include all standards in the curve-fit calculations. 

• Select YES to indicate that one or more standard replicates or groups 
should be temporarily excluded from curve-fit calculations. 

 If Average Standards was set to NO in the assay definition, one or more 
standard replicates can be chosen for exclusion. 
 

E D I T   S T D  1   R E P 1 ?   Y E S        

  Y E S    N O                              

 Select YES to exclude the replicate from curve-fit calculations. 

 Select NO to retain the replicate. 

 Press Enter to advance to the next replicate. 

 If Average Standards was set to YES in the assay definition, one or more 
standard groups can be chosen for exclusion. 

E D I T   S T D  1 ;  X ?  Y E S             

  Y E S    N O                              

 Select YES to exclude the group from curve-fit calculations. 

 Select NO to retain the group. 

 Press Enter to advance to the next group. 
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L Each curve-fit type requires a minimum number of standards for 
curve generation:  4 for 2-P, 4-P, cubic, and cubic-spline; 3 for 
quadratic; and 2 for linear and point-to-point. Exercise caution 
when editing outliers. If the assay is left with insufficient 
standards, the curve fit will fail. 

 

Printing Results 

After the assay is selected and standard outliers are edited (if necessary), the results 
report can be printed. 

P R I N T   R E S U L T S ?                    

  Y E S    N O                              

• Ensure that the printer is connected, turned on, and filled with paper. 

• Select YES to print reports, or NO to return to the Main Menu. 

Map 

• Select REPORT at the Main Menu, and then select MAP. 

S E L E C T   A S S A Y   N U M B E R : 0 1    

N  A M E :  H B S - A G                      

• Press Options to cycle through the list of available assays, or enter the 
number of the desired assay. 

• Press Enter to print the report. 

Assay  
• Select REPORT at the Main Menu, and then select ASSAY. 

S E L E C T   A S S A Y   N U M B E R : 0 1    

N  A M E :  H B S - A G                      

• Press Options to cycle through the list of available assays, or enter the 
number of the desired assay. 

• Press Enter to print the report. 

List  
• Select REPORT at the Main Menu, and then select LIST. The entire list of 

assays stored in the ELx800’s memory will be sent to the printer. 
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Using the Utility Options 

The UTILITY option allows you to set up the date and time, specify your data output and 
report options, and select your read options. 

Setting the Date and Time 

To set the current Date and Time, and/or change their formats: 

1. From the Main Menu, select UTIL > SETUP. The Edit Setup Information 
menu appears: 

E D I T  S E T U P  I N F O R M A T I O N :   

 D A T E   T I M E  F I L T E R  * M O R E 

2. Select DATE. The Date entry screen appears: 

D A T E :   0 8 / 2 3 / 0 9       M D Y 

M M D D Y Y       D D M M Y Y       

• Enter the new date using the numeric keys on the keypad. The cursor 
is positioned under the first editable field and advances automatically.  

• To change the date format, press the soft key beneath MMDDYY or 
DDMMYY. The display automatically updates to reflect the new format.  

• Press Enter to return to the Edit Setup Information menu.  

3. To change the current time and/or the time format, select TIME from the 
Edit Setup Information menu. The Time entry screen will appear: 

T I M E :    1 2 : 4 7 P M    1 2 H O U R 

1 2 H O U R      2 4 H O U R   A M / P M 

• Enter the time using the numeric keys on the keypad. The cursor is 
positioned under the first editable field and advances automatically. 

• To change the time format, select 12HOUR or 24HOUR, then AM or 
PM. The display automatically updates to reflect the new format. 

• Press Enter to return to the Select Utility Option menu. 
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Viewing/Editing the Filter Table 

After installing new filters, ensure that the ELx800’s filter table (the reader’s software 
reference for filter locations) matches the physical location of the filters in the filter 
wheel. 

1. From the Main Menu, select UTIL > SETUP > FILTER. 

2. The wavelength for Filter #1 will be displayed. To change a filter 
wavelength value, use the keypad to enter a number at the cursor location. 
The cursor will automatically advance to the next editable location. Press 
the Enter key to save the value and move to the next filter.  

E N T E R                    

F I L T E R # 1   W A V E L E N G T H : 4 0 5 

3. After entering the last filter, press the Main Menu key. 

Specifying Data Output and Reporting Options 

 These options have no effect on data output if the reader is being 
controlled by software (such as Gen5) running on a host computer. 

Plate data can be sent to an attached printer or external computer. 

• The onboard software provides several options for report format and 
content. 

• Data sent to an external computer has no data reduction applied to it, with 
the exception of dual-wavelength subtraction (if defined in the assay). Any 
reporting options selected through the onboard software have no effect on 
serial output. 

1. To specify data output and reporting options, start at the Main Menu and 
select UTIL > OUTPUT. The Report Output screen will appear. 

R E P O R T  O U T P U T :  B O T H      

P R I N T    C O M P U T E R  B O T H    

• Select PRINT to send reports directly to a printer, COMPUTER to send 
data out through the serial port, or BOTH. 

2. Press Enter to continue. The Select Printer screen will appear. 

S E L E C T  P R I N T E R       E P S O N 

E P S O N    H P               

 The ELx800 supports printers using HP's PCL3 language, such as 
the HP DeskJet series. For the latest list of compatible printers, 
consult the BioTek website, or call BioTek TAC. 
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3. Select HP and press Enter to continue. The Report Type screen will appear. 

R E P O R T  T Y P E :      C O L U M N   

C O L U M N           M A T R I X     B O  T H 

4. The currently selected report type is displayed in the top line. Select 
COLUMN to print information in a list (columnar) format, MATRIX to print 
in a format that resembles the plate type (eg.,  8 x 12 matrix), or BOTH.  

 See Appendix A for sample reports. 

5. Press Enter to continue. The Samples on Column Report screen will appear. 

S A M P L E S   O N   C O L   R P T ?   N O  

  Y E S      N O                             

6. Select YES to print results for all wells on the plate, including samples, or NO 
to limit the results information to blanks, controls, and standards. 

7. Press Enter to continue. If applicable, the Print Curve-Fit screen will appear.  

P R I N T  C U R V E - F I T ?      N O  

 Y E S     N O                 

8. Select YES to print the standard curve (only applies to quantitative assays). 

9. Press Enter to return to the Select Utility Option screen. 

Selecting Read Options 

The software can be configured to present the user with a series of prompts at plate-
read time, to enter information such as Plate ID, Sample ID, or Sample Count. 

1. To specify various read-time options, start at the Main Menu and select 
UTIL > READ.  

• The Prompt for Plate ID screen will appear. Select YES or NO and press 
Enter to cycle through the remaining prompts. 

P R O M P T   F O R   P L A T E   I D ?   Y E S 

 Y E S     N O                 

 
P R O M P T   F O R    S A M P L E   I D ? Y  E S 

 Y E S     N O                 
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P R O M P T   S A M P L E   C O U N T ?  Y E S 

 Y E S     N O                 

If selected, at read-time: 

• PLATE ID prompts for microplate identification. 

• SAMPLE ID prompts for identification for each sample group. 

• SAMPLE COUNT prompts for the number of samples on the plate. 

R E A D   I N   R A P I D   M O D E ?     Y E S 

 Y E S     N O                 

• RAPID MODE reads a 96-well plate in approximately 30 seconds 
(single-wavelength assay). If set to NO, the plate will be read in Normal 
Mode (approximately 50 seconds). See Chapter 1 for specifications. 

Changing the Baud Rate 

To change the baud rate from the instrument keypad: 

1. Select UTIL > SETUP > RS232. 

2. The Select Baud Rate screen will appear, showing the currently defined 
Baud Rate: 

S E L E C T  B A U D  R A T E :  9 6 0 0   

 1 2 0 0   2 4 0 0   9 6 0 0   V I E W  

• Select the desired baud rate. 

• Select VIEW, if you wish, to see the reader’s other communication 
settings. 

R S 2 3 2  S E T T I N G : N O   P A R I T Y 

2  S T O P - B I T S   8  D A T A - B I T S 

 Note: Gen5 requires a baud rate of 9600. 
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Recommendations for Optimum Performance 

• Microplates should be perfectly clean and free of dust or bottom scratches. Use 
new microplates from sealed packages.  

• Do not allow dust to settle on the surface of the solution; use microplate covers 
when not reading the plate. Filter solutions to remove particulates that could cause 
erroneous readings. 

• Although the reader supports standard flat, U-bottom, and V-bottom microplates, 
optimum performance is achieved with optically clear, flat-bottomed wells. 

• Non-uniformity in the optical density of the well bottoms can cause loss of 
accuracy, especially with U- and V-bottom polyvinyl microplates. Check for this 
by reading an empty microplate. Dual-wavelength readings can eliminate this 
problem, or bring the variation in density readings to within acceptable limits for 
most measurements. 

• Inaccuracy in pipetting has a large effect on measurements, especially if smaller 
volumes of liquid are used. For best results, use at least 100 µL per well in a 96-
well plate. 

• ELx800NB model only: Dispensing solution into 384-well plates often traps air 
bubbles in the wells, which may result in inaccurate readings. A dual-wavelength 
reading method usually eliminates these inaccuracies; however, for best results, 
remove the air bubbles by degassing the plate in a vacuum chamber before 
reading.  

• The inclination of the meniscus can reduce reading accuracy in some solutions, 
especially with small volumes. Agitate the microplate before reading to help bring 
this problem within acceptable limits. Use Tween 20, if possible (or some other 
wetting agent) to normalize the meniscus. Some solutions develop menisci over a 
period of several minutes. This effect varies with the brand of microplate and the 
solution composition. As the center of the meniscus drops and shortens the light 
path, the density readings change. The meniscus shape will stabilize over time. 
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Overview 

This chapter contains BioTek Instruments’ recommended Installation Qualification (IQ), 
Operational Qualification (OQ), and Performance Qualification (PQ) procedures for all 
models of the ELx800 Absorbance Microplate Reader. 

Every ELx800 reader is fully tested at BioTek prior to shipment and should operate 
properly upon initial setup. If you suspect that a problem occurred during shipment, if 
you have received the equipment after returning it to the factory for service, and/or if 
regulatory requirements dictate that you qualify the equipment on a routine basis, you 
should perform the procedures outlined in this chapter. 

 An ELx800 Product Qualification Package (PN 7330538) is available for 
purchase. It contains procedures for performing IQ/OQ/PQ and 
Preventive Maintenance, with spreadsheets for analyzing results and 
checklists and logbooks. Contact your BioTek dealer for more information. 

Recommended Qualification Schedule 

The schedule below defines the factory-recommended intervals for qualifying an ELx800 
reader used two to five days a week. The actual frequency, however, may be adjusted 
depending on your usage of the instrument. This schedule assumes the reader is properly 
maintained as outlined in Chapter 5. 

 The risk factors associated with your tests may require that the 
Operational and Performance Qualification procedures be performed  
more or less frequently than shown here. 

Tests 

Installation 
Qualification 

Operational 
Qualification 

Performance  
Qualification 

Initially Initially/ 
Annually 

Monthly Quarterly 

System Self-Test, p. 73      

Checksum Test, p. 74     

Absorbance Plate Test, p. 74     

Liquid Test 1, p. 79*     

Liquid Test 2, p. 80*     

Liquid Test 3, p. 84** 
(Optional, for 340 nm)      

*    If you have an Absorbance Test Plate, run Liquid Test 1. If you do not have an  
     Absorbance Test Plate, run Liquid Test 2. 

**  Liquid Test 3 is optional. Run it if your worksite requires qualification at 
     wavelengths lower than those attainable with the Absorbance Test Plate. 

BioTek Instruments, Inc. 



Test Descriptions  |  71 
 

Test Descriptions 

System Test 

The System Test runs automatically whenever the instrument is turned on. It can also 
be performed manually using Gen5 software, or the keypad (UTIL > TESTS > 
SYSTEM). If the power-up System Test fails, the reader will “beep” repeatedly and 
display an error code; see Chapter 6.  

When run manually, a System Test report is printed (or displayed in Gen5). The report 
(sample shown on the next page) includes results for the System Optics Test and 
Autocal Analysis. We recommend saving System Test reports to document periodic 
testing and assist with troubleshooting. 

• The System Optics Test confirms that the light levels and electronic noise at all 
set wavelengths fall within factory accepted criteria, and accomplishes this by 
measuring the air and dark readings and evaluating them to ensure they fall 
within specified ranges. The Optics test also confirms adequate photodiode 
sensitivity, and overall system cleanliness. 

• Autocal is run only at the factory (or by an authorized service engineer) to 
calibrate the carrier axis of the instrument. The results of this test are included 
in the System Test Report. In the field, the alignment of the Absorbance Plate 
Test is used to verify that the carrier positioning is correct. 

Terms used on the System Test Report 
Air Blank A full light reading through a filter with no plate in the light path. 

Dark Current A reading taken with the light blocked to measure background 
light levels in the reading chamber. Also used as a measure of 
background electronic noise within the measurement circuit. 

Gain An automatic electronic adjustment to the measurement circuit. 
The gain adjustment compensates for changing light levels or 
filter variations. For example, if the lamp output decreases 
slightly, the gain will increase to make up the difference. 

Axis Refers to a motor for the filter wheel or plate carrier. 
Offset A numerical limit, usually a range. For example, if the gain fails 

an offset test, it may be too high or too low.  

Checksum Test 

The Checksum Test compares the basecode software to internally recorded checksum 
values to ensure that the programming has not been corrupted. The test runs 
automatically when the instrument is turned on, and it can be run manually using the 
keypad (UTIL > TESTS > CHKSUM). When run manually, the software displays the 
part numbers and versions of software currently loaded on the reader. If the test fails, 
the reader will “beep” repeatedly and display an error code; see Chapter 6.  
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   Gen5 System Test Report 
 
Reader:   ELx800  (Serial Number: 203828) 
Basecode:   P/N 7330202  (v3.07) 
Date and Time:  9/23/2012 4:20:15 PM 
User:   Administrator 
Company:                       
Comments:                      
 
Test Results 

Operator ID:________________________________________________________ 

Notes:______________________________________________________________ 
 
04:21PM    9/23/2012     SYSTEM SELF TEST   
 
Filter: 405   Gain:  5.33 
Air:         54279 
Dark:           1055 
Delta:       53224 
 
Filter: 450   Gain:  2.19 
Air:         54802 
Dark:           1053 
Delta:       53749 
 
Filter: 490   Gain:  1.80 
Air:         54703 
Dark:           1053 
Delta:       53650 System Optics Test 
 
Filter: 630   Gain:  2.25 
Air:         54626 
Dark:           1053 
Delta:       53573 
 
Filter: 340   Gain: 85.33 
Air:         41582 
Dark:           1091 
Delta:       40491 
 
Noise Max:    1071 
Noise Min:    1069 
Delta:                 2 
 
AUTOCAL ANALYSIS   

AUTOCAL ANALYSIS provides coordinates of 
the last Autocal performed on the instrument. 
AUTOCAL verification is not included in the 
SYSTEM TEST result given below. 

 
Upper Left Corner:    x=      9198    y=10814     
Lower Left Corner:    x=      9200    y=16346     
Lower Right Corner:   x=       516    y=16340     
Upper Right Corner:   x=       514    y=10806     
Delta 1:   9198   - 9200=       -2 
Delta 2:    514   -  516=       -2 
Delta 3:  10806   -10814=       -8 
Delta 4:  16340   -16346=       -6 
 
SYSTEM TEST PASS         
-000 

The SYSTEM TEST result will be either PASS or FAIL. The SYSTEM 
TEST result refers only to the System Optics Test results. 

 
 

Figure 9: Sample System Test report (it varies slightly depending on how it was run) 
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Liquid Tests 

Conducting Liquid Tests confirms the reader‘s ability to perform to specification with 
liquid samples. Liquid testing differs from testing with the Absorbance Test Plate in 
that liquid in the wells has a meniscus, whereas the test plate’s neutral density glass 
filters do not. The optics characteristics may differ in these two cases, thus alerting the 
operator to different types of problems. The liquid tests will help to detect optical 
defects or contamination that can contribute to errant readings. 

• Liquid Test 1 confirms repeatability and consistency of the reader when a 
solution is used in the microplate. If these tests pass, then the lens placement 
and system cleanliness are proven.  

• Liquid Test 2 can be used to test the linearity, repeatability, and alignment of 
the reader if you do not have an Absorbance Test Plate.  

• Liquid Test 3 is an optional test and can only be performed with the “UV” 
model. It is offered for those sites that must have proof of linearity at 
wavelengths lower than those attainable with the Absorbance Test Plate. This 
test is optional since the ELx800 has good “front end” linearity throughout the 
specified wavelength range. 

Absorbance Plate Test  

This test uses BioTek’s Absorbance Test Plate to confirm the Mechanical Alignment, 
Accuracy and Linearity, and Repeatability of the ELx800. The Absorbance Plate Test 
compares the reader’s optical density measurements and mechanical alignment to NIST-
traceable values. 

 An alternate method for confirming accuracy, linearity, and repeatability 
is Liquid Test 2, described on page 80. 

 The BioTek PN 7260522 Test Plate has a glass filter in location C6, which 
is used to check the wavelength accuracy of a monochromator. Although 
the ELx800 does not have a monochromator, you must enter values for 
the peak wavelength when defining the 7-filter test plate in Gen5 
software. Refer to the software help system for more information. 

Perform the Tests 

System Test 

 If the System Test fails, see Chapter 6 for troubleshooting tips and 
error code descriptions. 

Using the keypad: 

1. Attach a printer to the instrument.  

2. From the Main Menu, select UTIL > TESTS > SYSTEM. 
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Using Gen5: 

• From the main screen, select System > Diagnostics > Run System Test 

Checksum Test 

Using the keypad, start at the main menu and select UTIL > TESTS > CHKSUM.  

• The initial checksum test display will show the onboard (base code) 
software part number, version number, and checksum.  

• After a few moments, a second screen will show the assay configuration 
software part number and version number. 

 There is no Checksum Test in Gen5. To obtain reader software 
information, start at the main screen and select System > Reader 
Control > ELx800.  

Absorbance Plate Test 

To run this test, you will need BioTek’s Absorbance Test Plate (PN 7260522), with its 
accompanying data sheet.  

• The Absorbance OD Standards section contains NIST-traceable standard OD 
values for the filters at several different wavelengths. We recommend testing at six 
wavelengths; those at or close to the wavelengths used in your assays. 

• The Wavelength Accuracy Standards section contains Expected Peak wavelength 
values for the filter in position C6 on the plate.  

 The instructions provided below are guidelines. Refer to the Gen5 Help 
system for more information. 

Define the Test Plate in Gen5 

 The BioTek PN 7260522 Test Plate has a glass filter in location C6, which 
is used to check the wavelength accuracy of a monochromator. Although 
the ELx800 does not have a monochromator, you must enter values for 
the peak wavelength when defining the 7-filter test plate in Gen5 
software. Refer to the software help system for more information. 

Before the Absorbance Plate Test can be performed, the standard OD and peak 
wavelength values must be entered into Gen5. You will enter and save these values 
once initially, and then update them each time the test plate is recertified by BioTek 
(typically annually).  

• From the main screen, select System > Diagnostics > Test Plates > 
Add/Modify Plates. 

• Click Add. Select the Plate Type and enter the Serial Number. 
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Run the Absorbance Plate Test 

Using the keypad: 

1. From the main menu select UTIL > SETUP > *MORE > CALPLATE. The 
Calibration Filter screen will appear. 

2. Select a filter wavelength and press Enter. The Wavelength / Calibration 
Value screen will appear.    

3. Enter the values listed on the Test Plate data sheet. After each entry, press 
Enter to advance to the next well location.  

4. Repeat for the remaining filters. 

5. When all values have been entered, press the Main Menu key. 

6. From the main menu, select UTIL > TESTS > CALPLATE. The Calibration 
Filter screen will appear. 

7. Select the appropriate wavelength and press Enter. 

8. When prompted, insert the Test Plate into the plate carrier, and press the 
READ key to begin the test. The Test Plate Analysis Report (sample on page 
76) will be sent to a printer when the test is complete. 

Using Gen5: 

1. From Gen5’s main screen, select System > Diagnostics > Test Plates > 
Run. If prompted, select the desired Test Plate and click OK. 

2. Place the Test Plate in the microplate carrier so that well A1 is in the left-
rear corner of the carrier (as you are facing the carrier). 

3. Click OK to run the test.  

4. When the test completes, the results report will appear. Scroll down 
through the report; every result should show ‘PASS’. See page 76 for 
information on results and troubleshooting tips in the event of failures. 

• A sample test report is shown below. 

• Gen5 stores the results in a database; they can be retrieved and printed 
at any time. We recommend you print and save the report to document 
that the test was performed. 
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Sample Absorbance Plate Test Report 

 
Alignment Results: 
 WELLS         B2      B12       G1      G11   
 DATA        0.000    0.000    0.000    0.000   
 TOLERANCE   0.015    0.015    0.015    0.015   
 RESULT       PASS     PASS     PASS     PASS   
 
Wavelength = 405 nm 
 
Accuracy Results: 
 WELLS         C1       E2       G3       H6       F5       D4   
 STANDARD    0.147    0.618    1.133    1.701    2.279    2.945   
 MIN. VALUE  0.124    0.586    1.090    1.647     #N/A     #N/A   
 MAX. VALUE  0.170    0.650    1.176    1.755     #N/A     #N/A   
 DATA        0.148    0.616    1.129    1.695    2.243    2.850   
 RESULT       PASS     PASS     PASS     PASS     #N/A     #N/A   
 
Repeatability Results: 
 WELLS         C1       E2       G3       H6       F5       D4   
 READ1       0.148    0.616    1.129    1.695    2.243    2.850   
 MIN. VALUE  0.137    0.600    1.108    1.668     #N/A     #N/A   
 MAX. VALUE  0.159    0.632    1.150    1.722     #N/A     #N/A   
 READ2       0.149    0.616    1.130    1.695    2.242    2.853   
 RESULT       PASS     PASS     PASS     PASS     #N/A     #N/A   

 

Figure 10: Sample Test Plate Analysis Report 

 The report varies slightly depending on how it was run (via the keypad or 
Gen5). 

 Important! The Absorbance Plate Test tests the accuracy and 
repeatability specifications from 0.000 to 2.000 OD only. In the example 
above, the Analysis report displays the OD values read in well positions 
D04 and F05 but does not indicate PASS or FAIL, because the values are 
higher than 2.000 OD and therefore are not within the test range. 

Results and Troubleshooting Tips 

• Alignment Results: The test plate has several groups of precisely machined holes 
to confirm the mechanical alignment of different microplate readers. The amount 
of light that shines through these holes indicates whether the reader is properly 
aligned with the absorbance optical path. A reading of more than 0.015 OD for any 
of the designated alignment wells indicates that the light is being “clipped” and 
the reader may be out of alignment. If the test fails: 

 Ensure that the Test Plate is correctly seated in the microplate carrier. 

 Check all of the plate’s corner alignment holes to ensure they are clear of 
debris. 

 Check the microplate carrier to ensure it is clear of debris. 

• Accuracy Results: The Test Plate contains six neutral-density glass filters of 
assigned OD values at several wavelengths. Since there are several filters with 
differing OD values, the accuracy across a range of ODs can be established. Once it 
is shown that the device is accurate at these OD values, then, by definition, it has 
to be linear. To further verify this, perform a regression analysis on the Test Plate 
OD values in a program such as Microsoft Excel. An R Square value of at least 
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0.990 is expected. Note: There may not be a Pass/Fail indication for filter values 
that are beyond the specified accuracy range of the instrument. If the test fails: 

 Check the neutral-density filters in the Test Plate to ensure they are clean. If 
necessary, clean them with lens paper. Do not remove the filters from the test 
plate, and do not use alcohol or other cleaning agents. 

 Verify that the filter calibration values entered in Gen5 are the same as those 
on the Test Plate data sheet.  

 Verify that the Test Plate is within its calibration certification period. The 
calibration sticker is affixed directly to the plate. If it is out of date, contact 
BioTek to schedule a recertification. 

• Repeatability Results: This test ensures the instrument meets its repeatability 
specification by reading each neutral-density filter on the Test Plate twice with the 
filter in the same location. Note: There may not be a Pass/Fail indication for filter 
values that are beyond the specified accuracy (and, thus, repeatability) range of the 
device. If the test fails: 

 Check the neutral-density filters on the Test Plate to ensure there is no debris 
that may have shifted between readings and caused changes. 

 Check the microplate carrier to ensure it is clear of debris. 
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Liquid Tests 

Prepare Test Solutions 

BioTek offers a dye solution (PN 7120779, 25 mL; or 7120782, 125 mL) for use with 
the stock solution formulation for Liquid Tests 1 and 2, or, if you prefer, you may 
use the dye solution described below. The purpose of the formulation is to create a 
solution that absorbs light at ~ 2.000 OD full strength when dispensed at 200 µL in 
a flat-bottom microplate well. 

Alternatively, any solution that gives a stable color will suffice. (This includes 
substrates incubated with an enzyme preparation and then stopped with an acidic 
or basic solution.) Some enzyme/substrate combinations that may be used as 
alternates to the described dye are shown below: 

                 Typical Enzyme-Substrate Combinations and Stopping Solutions 

Enzyme Substrate Stopping Solution 

Alkaline Phosphate o-nitrophenyl phosphate 3N sodium hydroxide 

beta-Galactosidase o-nitrophenyl-beta-D 
galactopyranoside 

1M sodium carbonate 

Peroxidase 2,2'-Azino di-ethylbenzothiazoline-
sulfonic acid (ABTS) 

citrate-phosphate buffer, 
pH 2.8 

Peroxidase o-phenylenediamine 0.03N sulfuric acid 

 

Stock Solution Formulation 

The stock solution for Liquid Tests 1 and 2 may be formulated using the materials 
listed below (Solution A), or by diluting a dye solution available from BioTek 
(Solution B). 

 Either solution should result in an absorbance of about 2.000 when 
using 200 µL in a flat-bottom microwell at 405 nm. The OD value will be 
proportional to the volume in the well and the amount of FD&C No. 5 
dye or QC Check Solution used. You can use a larger or smaller well 
volume, or add more dye or water to adjust the solution. Note that too 
small a well volume may result in increased pipetting-related errors. 

Solution A  

Required Materials 

• BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; or 7120782, 125 mL) 

• Deionized water 

• 5-mL Class A volumetric pipette 

• 100-mL volumetric flask 
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Prepare Stock Solution 

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a  
100-mL volumetric flask.  

2. Add 95 mL of DI water; cap and shake well.  

Solution B 

Required Materials 

• Deionized (DI) water 

• FD&C Yellow No. 5 dye powder (typically 90% pure) 

• Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting 
agent, PN 7773002 (a 10% Tween solution) 

• Precision balance with a capacity of 100 g minimum and readability of  
0.001 g 

• Weigh boat 

• 1-liter volumetric flask 

 
Prepare Stock Solution 

1. Weigh out 0.092 gram of FD&C No. 5 yellow dye powder into a weigh boat. 

2. Rinse the contents into a 1-liter volumetric flask. 

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent. 

4. Make up to 1 liter with DI water, cap, and shake well. 

 

L 96-well, flat-bottom microplates are required for the liquid tests 
(Corning Costar #3590 is recommended). Use new microplates; 
any fingerprints or scratches may cause variations in readings. 

Before running the tests, ensure that the reader is not running in 
Rapid Mode. To check this, select UTIL > READ and then cycle 
through the prompts until READ IN RAPID MODE? is 
displayed. Choose NO for an accurate result. 

Perform Liquid Test 1  

1. Using freshly prepared stock solution A or B (the concentrated solution), 
prepare a 1:2 dilution using DI water (one part stock, one part DI water; the 
resulting solution is a 1:2 dilution).  

2. Pipette 200 µL of the concentrated solution into Column 1 of the plate. 

3. Pipette 200 µL of the diluted solution into Column 2 of the plate. 
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 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the plate 
for four minutes. This will allow any air bubbles in the solution to 
settle and the meniscus to stabilize. If a plate shaker is not 
available, wait 20 minutes after pipetting the diluted test solution 
before reading the plate. 

4. Read the microplate five times at 405 nm using the Normal Read Mode 
(Chapter 3), single wavelength, no blanking. 

5. Print the five sets of raw data or export it to an Excel spreadsheet using Gen5. 

 If you are exporting the data to your own Excel spreadsheet, 
perform the calculations described below and keep the spreadsheet 
for future tests. 

Calculations 

1. Calculate the mean and standard deviation for each well location in columns 
1 and 2 for the five plates read.   

2. For each mean below 2.000 OD, calculate the allowed deviation using the 
repeatability specification for a 96-well format of ± 0.5% ± 0.005 OD. 

3. The standard deviation for each set of readings should be less than the 
allowed deviation. 

For example:  Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will 
result in a mean of 1.951, and a standard deviation of 0.0026. The mean 
(1.951) multiplied by 0.5% (1.951 * 0.005) = 0.0098, which, when added to the 
0.005 (0.0098 + 0.005) = 0.0148 OD, which is the allowable deviation. Since the 
standard deviation is less than this value, the reader meets the test criteria.   

Repeatability Specification: For comparison in this test, the following 
repeatability specification is applied, using the Normal Read Mode and a 96-
well microplate. ± 0.5% ± 0.005 OD from 0.000 to 2.000 OD @ 405 nm 

 

Perform Liquid Test 2 

 The recommended method of testing the instrument performance is to 
use the Absorbance Test Plate to confirm alignment, repeatability, and 
accuracy, which will also confirm linearity. If a Test Plate is not 
available, Liquid Test 2 can be used for these tests. 

Required Materials 

• A new 96-well, flat-bottom microplate (Corning Costar #3590 is 
recommended) 
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• Ten test tubes, numbered consecutively, stored in a rack 

• Calibrated hand pipette (Class A volumetric pipette recommended) 

• Stock solution A or B (these are the same solutions as for Liquid Test 1) 

• A 0.05% solution of deionized water and Tween 20 

Prepare Dilutions 

Create a percentage of dilution series, beginning with 100% of the original 
concentrated stock solution (A or B) in the first tube, 90% of the original 
solution in the second tube, 80% in the third tube, all the way to 10% in the 
tenth tube. Dilute using the 0.05% solution of deionized water and Tween 20. 
This solution can also be made by diluting the BioTek wetting agent 200:1. 

                  Test Tube Dilutions 

Tube Number 1 2 3 4 5 6 7 8 9 10 

Volume of Concentrated 
Solution (mL) 

20 18 16 14 12 10 8 6 4 2 

Volume of 0.05% Tween 
Solution (mL)  

0 2 4 6 8 10 12 14 16 18 

Absorbance expected  
if concentrated solution 
is 2.0 at 200 µL 

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2 

 

 The choice of dilutions and the absorbance of the original solution can 
be varied. Use this table as a model for calculating the expected 
absorbances of a series of dilutions, given a different absorbance of 
the original solution. 

Prepare the plate 

1. Pipette 200 µL of the concentrated solution from tube 1 into each well of the 
first column, A1 to H1, of the microplate.  

2. Pipette 200 µL from each of the remaining tubes into the wells of the 
corresponding column of the microplate (tube 2 into wells A2 to H2, etc.). 
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 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the plate 
for four minutes. This will allow any air bubbles in the solution to 
settle and the meniscus to stabilize. If a plate shaker is not 
available, wait 20 minutes after pipetting the diluted test solution 
before reading the plate. 

Perform the Test 

1. Read the microplate prepared above five times using Normal Read Mode 
dual wavelength at 450 nm with 630 nm as the blank.  

 Do not discard the plate; you will use it for the Alignment Test. 

2. Print the raw data or export it to an Excel spreadsheet using Gen5. 

 If you are exporting the data to an Excel spreadsheet, perform the 
calculations described below and on the following page, and keep 
the spreadsheet for future tests. 

Calculations 

 Linearity 
1. Calculate the mean absorbance for each well, and average the means for each 

concentration. 

2. Perform a regression analysis on the data to evaluate linearity. 

Expected Results: Since it is somewhat difficult to achieve high pipetting 
accuracy when conducting linear dilutions, an R-Square value greater than 
or equal to 0.990 is considered adequate. 

Repeatability 
1. Calculate the mean and standard deviation for the five readings taken above 

at each concentration. Only one data set needs to be analyzed for each 
concentration. The well that shows the most variation for each concentration 
is selected for data reduction. 

2. For each mean below 2.000 OD, calculate the allowed deviation using the 
repeatability specification for a 96-well format of ± 0.5% ± 0.005 OD from 
0.000 to 2.000 OD @ 405 nm. 

3. The standard deviation for each set of readings should be less than the 
allowed deviation. 

For example: Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will 
result in a mean of 1.951, and a standard deviation of 0.0026. The mean 
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(1.951) multiplied by 0.5% (1.951 * 0.005) = 0.0098, which, when added to the 
0.005 (0.0098 + 0.005) = 0.0148 OD, which is the allowable deviation. Since the 
standard deviation is less than this value, the reader meets the test criteria. 

Repeatability Specification 

For comparison in this test, the following repeatability spec is applied, 
using Normal mode, 96-well microplate: 

± 0.5% ± 0.005 OD from 0.000 to 2.000 OD @405 nm 

 Alignment 
1. Using the prepared plate, conduct a turnaround test by reading the plate 

with the A1 well in the H12 position five times. This test results in values for 
the four corner wells that can be used to determine alignment. 

2. Calculate the means of wells A1 and H1 in the normal plate position (data is 
from Linearity Test) and in the turnaround position (from Step 1 above). 
Compare the mean reading for well A1 to its mean reading when in the H12 
position. Next, compare the mean values for the H1 well to the same well in 
the A12 position. The difference in the values for any two corresponding 
wells should be within the accuracy specification for the instrument. 

For example: If the mean of well A1 in the normal position is 1.902, where the 
specified accuracy is ± 1.0% ± 0.010 OD, then the expected range for the mean 
of the same well in the H12 position is 1.873 to 1.931 OD.  

(1.902 * 1% = 0.019 + 0.010 = 0.029, which is added and subtracted from 1.902 
for the range.) 

3. If the four corner wells are within the accuracy range, the reader is in 
alignment. 

Accuracy Specification 

For comparison in this test, the following accuracy specification is applied, 
using Normal Mode and a 96-well microplate: ± 1.0% ± 0.010 OD from 0.000 
to 2.000 OD @ 405 nm 
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Perform Liquid Test 3 (“UV” Models Only)  

 Liquid Test 3 is an optional test offered for sites that must have proof 
of linearity at wavelengths lower than those attainable with the 
Absorbance Test Plate. This test verifies operation of the ELx800 at 
340 nm and is optional because the reader has good “front-end” 
linearity throughout its wavelength range. 

Required Materials 

• 340 nm filter installed in the reader 

• New 96-well, flat-bottom microplates (Corning Costar® #3590 is 
recommended) 

• Calibrated hand pipette(s) 

• Beakers and graduated cylinder 

• Precision balance with readability to 0.01 g 

• Buffer solution as described below 

Buffer Solution  

• Deionized water 

• Phosphate-buffered saline (PBS), pH 7.2-7.6, Sigma tablets #P4417 (or 
equivalent) 

• β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced 
Form) Sigma bulk catalog number N 8129, or preweighed 10-mg vials, 
Sigma number N6785-10VL (or BioTek PN 98233). Store the powder 
according to the guidelines on its packaging. 

1. Prepare a PBS solution using the Sigma tablets. 

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH 
powder and mix thoroughly. This is the 100% Test Solution. 

3. (Optional) Read a 150-µL sample of the solution at 340 nm; it should be 
within 0.700 to 1.000 OD. If low, adjust up by adding more powder. Do not 
adjust if slightly high. 

Prepare and Read the Plate 

1. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution 
with 5 mL of the PBS solution. 

2. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution 
with 10 mL of the PBS solution. 
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3. Pipette the three solutions into a new 96-well microplate: 

• 150 µL of the 100% Test Solution into all wells of columns 1 and 2 

• 150 µL of the 75% Test Solution into all wells of columns 3 and 4 

• 150 µL of the 50% Test Solution into all wells of column 5 and 6 

 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the 
plate for four minutes. This will allow any air bubbles in the 
solution to settle and the meniscus to stabilize. If a plate 
shaker is not available, wait 20 minutes after pipetting the 
diluted test solution before reading the plate. 

5. Read the microplate five times using Normal Mode, single wavelength at 340 
nm, no blanking (or blank on air). 

6. Print the five sets of raw data or export it to an Excel spreadsheet using Gen5. 
 

Calculations 

 Repeatability 
1. For each well, calculate the mean and standard deviation of the five readings. 

2. For each mean calculated in step 1, calculate the allowed deviation using the 
repeatability specification for a 96-well plate in the Normal Read Mode, 
which is ± 1.5% ± 0.005 OD from 0.000 to 2.000 OD @340 nm (mean * 0.015  
+ 0.005). 

3. For each well, compare the standard deviation calculated in step 1 with the 
allowed deviation calculated in step 2.  The standard deviation should be less 
than the allowed deviation. For example: Absorbance readings of 0.802, 0.802, 
0.799, 0.798, and 0.801 will result in a mean of 0.8004 and a standard 
deviation of 0.0018. The mean multiplied by 1.5% (0.8004 * 0.015) equals 
0.012, and when added to the 0.005 (0.012 + 0.005) equals 0.017, which is the 
allowed deviation for well A1. Since the standard deviation for well A1 is less 
than 0.017, the well meets the test criteria. 
 

Linearity 
1. For each of the three dye concentrations, calculate the mean absorbance for 

the wells containing that solution (mean of wells A1 to H2, A3 to H4, and A5 
to H6). 

2. Perform a regression analysis on the data to determine if there is adequate 
linearity. 

Expected Results: Since it is somewhat difficult to achieve high pipetting 
accuracy when conducting linear dilutions, an R-Square value greater than 
or equal to 0.990 is considered adequate. 
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Overview 

A daily preventive maintenance routine is the best way to ensure accurate performance 
and a long life for your instrument. Frequent cleaning of the microplate carrier and all 
exposed surfaces of the instrument will help to reduce the amount of particulates or dust 
that can cause erroneous readings. 

 

 

Warning! Internal Voltage. Always turn off and disconnect the 
reader from the power supply for all cleaning operations. 

 

Do not immerse the instrument, spray it with liquid, or use a “wet” 
cloth. Do not allow the cleaning solution to run into the interior of the 
reader. If this happens, contact the BioTek Service Department. 

Do not soak the keypad—this will cause damage. Moisten a clean 
cloth with deionized or distilled water and wipe the keypad. Dry 
immediately with a clean, dry cloth. 

Do not apply lubricants to the microplate carrier or carrier track. 
Lubrication on the carrier mechanism or components in the carrier 
compartment will attract dust and other particles, which may obstruct 
the carrier path and cause the reader to produce an error. 

 

Routine Cleaning Procedure 

You will need a mild detergent, deionized or distilled water, and clean, lint-free cotton 
cloths. 

1. Turn off and disconnect the instrument from the power supply. 

2. Moisten a clean cotton cloth with water, or with water and the mild detergent. 
Do not soak the cloth. 

3. Wipe the plate carrier and all exposed surfaces of the instrument.  

4. If detergent was used, wipe all surfaces with a cloth moistened with water. 

5. Use a clean, dry cloth to dry all wet surfaces. 
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Decontamination Procedure 

Any laboratory instrument that has been used for research or clinical analysis is 
considered a biohazard and requires decontamination prior to handling. Decontamination 
minimizes the risk to all who come into contact with the instrument during shipping, 
handling, and servicing. Decontamination is required by the U.S. Department of 
Transportation regulations. Persons performing the decontamination process must be 
familiar with the basic setup and operation of the instrument. 

 

L BioTek Instruments, Inc. recommends the use of the following 
decontamination solutions and methods based on our 
knowledge of the instrument and recommendations of the 
Centers for Disease Control and Prevention (CDC). Neither 
BioTek nor the CDC assumes any liability for the adequacy of 
these solutions and methods. Each laboratory must ensure that 
decontamination procedures are adequate for the Biohazard(s) 
they handle. 

 

Wear prophylactic gloves when handling contaminated 
instruments. Gloved hands should be considered contaminated 
at all times; keep gloved hands away from eyes, mouth, nose, 
and ears. Eating and drinking while decontaminating 
instruments is not advised. 

Mucous membranes are considered prime entry routes for 
infectious agents. Wear eye protection and a surgical mask when 
there is a possibility of aerosol contamination. Intact skin is 
generally considered an effective barrier against infectious 
organisms; however, small abrasions and cuts may not always be 
visible. Wear protective gloves when performing the 
decontamination procedure. 

The bleach solution is caustic; wear gloves and eye protection 
when handling the solution. 

 

Tools and Supplies 

• Sodium hypochlorite (NaClO, or bleach) 

• 70% isopropyl alcohol (as an alternative to bleach) 

• Deionized or distilled water 

• Safety glasses 
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• Surgical mask 

• Protective gloves 

• Lab coat 

• Biohazard trash bags 

• 125 mL beakers 

• Clean, lint-free cotton cloths 

Procedure 

1. Turn off and unplug the instrument. 

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach). 
As an alternative, 70% isopropyl alcohol may be used if the effects of bleach are 
a concern. 

• Check the percent NaClO of the bleach you are using; this information is 
printed on the side of the bottle. Commercial bleach is typically 10.0% 
NaClO; if this is the case, prepare a 1:20 dilution. Household bleach is 
typically 5.0% NaClO; if this is the case, prepare a 1:10 dilution. 

3. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth. 

4. Wipe the keypad (do not soak). Wipe again with a clean cloth moistened with 
deionized or distilled water. Dry immediately with a clean, dry cloth. 

5. Wipe the plate carrier and all exposed surfaces of the instrument. 

6. Wait 20 minutes. Moisten a cloth with deionized or distilled water and wipe all 
surfaces of the instrument that have been cleaned with the bleach solution or 
alcohol. 

7. Use a clean, dry cloth to dry all wet surfaces. 

8. Discard the used gloves and cloths using a biohazard trash bag and an 
approved biohazard container. 

 

BioTek Instruments, Inc. 



Filter Storage and Handling  |  91 

Filter Storage and Handling 

To properly store interference filters during extended periods of non-use, package the 
filters in a light-tight envelope or container, away from high humidity. This will ensure the 
longest life for the filters. When handling the filters, keep the surfaces clean from 
fingerprints and debris by simply wiping with a lens tissue or other lint-free cloth. 

 

Replacing and Aligning the Bulb 

The lamp is rated for an average life of 600 hours. The intensity of the lamp will slowly 
drop over time until the run-time self-check detects a low signal level and the instrument 
displays an error code. The bulb should be replaced and aligned at this time.  

• For standard model readers, order replacement bulb kit PN 7330513.  

• For UV and NB model readers, order replacement bulb kit PN 7330516.  

The kits contain complete instructions for replacing and aligning the bulb. See page 91 for 
a detailed view of the lamp assembly. 

 

 
Warning! The lamp will be hot immediately after the reader 
has been shut down. Allow the lamp to cool down for at least 10 
minutes before attempting to replace the bulb. 

Warning! The alignment procedure requires you to observe the 
light path while the bulb is turned on. To prevent possible vision 
impairment, avoid looking directly at the bulb while it is on. 

 

Replace and Align the Bulb 

1. Unplug the instrument and turn it over on its back.  

2. Remove the four black screws that hold on the top shroud. 
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Figure 9: Removing the top shroud 

3. Turn over the instrument, and lift off the shroud. 

4. Loosen, but do not remove, both 3/32" hex screws that hold the lamp in place.  

  

Figure 10: Lamp assembly  

5. Slide the bulb out backward, and disconnect it from the connector at the back 
of the optics arm.  

6. Connect the new bulb, then insert the new bulb into the bulb retention springs. 

7. Power up the reader. The lamp should light and the instrument run its start-up 
test. Ignore any errors’ press the STOP key to stop the error. 
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8. Align the bulb: 

a. Press the UTIL key in the main menu.  

b. Press SETUP, then press MORE twice. 

c. Press BULB ALIGN. The carrier moves into a position that blocks the 
light beam. 

d. Push the bulb forward until it stops.  

e.  Rotate the bulb left and right and slightly in and out to obtain a full 
circular image on the carrier surface.  

f. Tighten the bulb retention screws, and check that the image is still 
aligned. 

9. Turn off the instrument and reinstall the shroud. 

 An optics arm cover is used only in UV/NB models. The standard model 
of the reader does not include the cover. 
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Chapter 6 

 

Troubleshooting and  
Error Codes 

 

This appendix describes error codes that may be displayed in Gen5 
or on the ELx800, and suggests possible solutions for these 
problems. 

Overview ........................................................................ 96 
General Error Codes (0100-1300) ...................................... 96 
Fatal Error Codes (A100-A900) ......................................... 100 
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Overview 

An error code is displayed as a four-digit identifier. The first character will be 0, 1, 2, or A. 

• “0”, “1”, or “2” indicates a noncritical or General Error. When this occurs, the 
instrument should still respond to input. Look up the error code on the following 
pages and try to resolve the error based upon the description/instructions offered 
for the code. If you cannot resolve the problem, contact BioTek’s Technical 
Assistance Center.   

• “A” indicates a Fatal Error. If this occurs, turn off the instrument, look up the error 
code on page 100, and contact BioTek’s Technical Assistance Center.  

The fourth digit of an error code typically signifies a particular motor sensor, optical 
sensor, or channel. This table lists the sensor/channel represented by the fourth digit: 

Motor or Optical Sensor Channel 

0 = Carrier X-Axis 0 = Reference 

1 = Carrier Y-Axis 1 = Measurement 

 

When contacting BioTek (see Chapter 1), please provide the following information: 

• Error code(s) displayed and the specific steps that produce your problem 

• Reader serial number (on the back of the instrument) 

• Reader software information: Part number, version number, checksum, and if 
applicable, Gen5 software information. See Product Support & Service in 
Chapter 1 for instructions for obtaining software versions. 

 

General Error Codes (0100-1300) 

General errors indicate nonfatal conditions that require attention. 

 
Code General Error Codes - Description and Probable Causes 

0100 Abort 
The read or task has been aborted. 

0101 Abort Error 
The read or task has been aborted. The 0101 indicates a software abort. 
Probable Causes: 
• User aborted read from Gen5. 
• User aborted from another serial interface. 

0200 X-axis (carrier in/out) motor did not find the opto (home) sensor  
A motor was unable to move to its “home” position as registered by feedback from 
an optical sensor. 
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Code General Error Codes - Description and Probable Causes 
Probable Causes: 
• Defective or broken optical sensor. 
• Flex cable is disconnected or damaged. 
• X-axis movement is limited so that the optical sensor cannot be interrupted. 
Note: In cases where a sensor is not functioning, the motor will drive the axis to 
its mechanical stop and generate substantial noise. 

0201 Y-axis (carrier left/right) motor did not find the home sensor  
A motor was not able to move to its “home” position as registered by feedback 
from an optical sensor. 
Probable Causes: 
• Defective or broken optical sensor. 
• Sensor not connected. 
• Y-axis movement is limited so that the optical sensor cannot be interrupted. 

0202 Filter wheel did not find opto (home) sensor 
Probable Cause: 
• Failed lamp. 

0300-
0301 

Light beam not found 
During the X-axis movement, the light beam (saturation) transition (max light to 
no light) was never found during autocalibration. 
Probable Causes: 
• Loose belt, loose motor pulley, or defective motor drive causing the carrier to 

ignore movement instructions. 
• Failed lamp. 
• Loose filter wheel drive gear or defective motor controller PCB. 

0302 Filter wheel failed positional verify 
• A failed lamp generates a 0302 error on power-up.  

0400 Carrier X-axis movement failed positional verify 
Motor X-axis failed to get to the same position when moved a known number of 
steps from the home position and back. 
Probable Causes: 
• The belt has slipped because of incorrect tension, a loose motor pulley, or a 

loose belt clamp. 
• Defective motor drive. 
• The carrier axis rail is dirty; the instrument should be serviced 

0401 Carrier Y-axis movement failed positional verify 
Motor X-axis failed to get to the same position when moved a known number of 
steps from the home position and back. 
Probable Causes: 
• The belt has slipped because of incorrect tension, a loose motor pulley, or a 

loose belt clamp. 
• Defective motor drive. 
• The carrier axis rail is dirty; the instrument should be serviced 

0402 Filter wheel failed positional verify; lamp failed 
Probable Causes: 
• Optical trigger flag has moved or is loose. 
• Filter wheel is binding against the motor gear. 
• Defective motor drive. 
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Code General Error Codes - Description and Probable Causes 
• Bearings caused motors to fail.  
• A failed lamp generates a 0402 error on power-up. 

0500 Filter not installed 
Probable Causes: 
• Empty filter location on the filter wheel (all filter locations must have either a 

filter or a filter blank, BioTek PN 2872086).  
• Entire filter wheel is not installed. 

0601 to 
0605 

Filters #1 through 5 Gain out of range 
Errors 0601 through 0605 indicate that the gain for a specific filter is out of range. 
Gain out of range indicates that the lamp is out, or that a particular filter absorbs 
or transmits entirely incorrect light levels. 
Probable Causes: 
• A missing, defective, or misplaced filter or filter blank will cause this error. 

Check to ensure that the filters in the wheel match the filters programmed in 
the software. Look for obvious physical defects in the filters. 

• Defective lamp providing reduced signal, causing the error. Check that the 
lamp is lit when the reader is ON. Replace lamp if necessary. 

• Misaligned optics. 

0700 Reader failed noise test 
Significant variations in background electronic noise were detected when blocking 
the light and increasing the gain to maximum. 
Probable Causes: 
• External signals may be penetrating the measurement chamber. Ensure that 

the bottom and top shrouds, as well as the filter wheel cover, are correctly 
installed. 

• A faulty motherboard or daughter board. 
• Photodiode or power supply may be too close to the instrument. 
• Failure indicates excessive variation in the dark current (background) noise 

levels of the measurement circuit. 

0800 Reader failed offset test 
During self-test, the background electronic signal detected is outside of acceptable 
limits at maximum gain when blocking the light. 
Probable Causes: 
If noise Max is > 20000. 
• Electrical noise may be penetrating the measurement chamber. The bottom 

and top shrouds are part of the electrical shielding. Check that the shrouds are 
installed and properly fastened. 

• There may be an ambient light leak. Ensure that the plate carrier door is 
properly closed. 

• Faulty motherboard or daughter board. 
• Photodiode or power supply may be too close to the instrument. 
• A missing or loose filter may be allowing unintended lamp light into the 

measurement chamber. Check the filter wheel for empty positions. 

0900 Read time dark value out of range 
The dark current value taken during the current read is significantly different than 
the same reading taken during the power-up self-check. 
Probable Cause: 
• The measurement electronics background noise has changed since the last 

power-up self-check. Electrical noise may be penetrating the measurement 
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Code General Error Codes - Description and Probable Causes 
chamber. The bottom and top shrouds are part of the electrical shielding. 
Check that the shrouds are installed and properly fastened. 

• Ambient light may have increased since power-up.  
• Faulty motherboard or daughter board. 

0A01-
0A05 

Read time Air Blank out of range 
The blank (full signal) reading taken during the current read has changed 
significantly from the same reading taken during the power-up self-check. 
Probable Cause: 
• Lamp is unstable. Reboot system and/or install new lamp. Turn unit OFF 

when not in use to conserve lamp life.  

0B00 Invalid assay 
An assay number that is not programmed was selected. 

0C00 Printer timed out 
The time allotted for the instrument to make a valid connection to a printer has 
expired. Note: This error only appears in readers shipped before April 2004, and 
that have not had a basecode update. 
Probable Causes: 
• Printer not connected, on line, or powered up. 
• Printer parallel port may not be correctly selected. 

Errors 0D00 through 1300 indicate that the reader has failed one or more of a number of self-
tests. 

0D00 Calibration checksum error 
Reader failed calibration checksum test. 
Probable Cause: 
• The stored checksum value for the calibration data does not match the actual 

checksum. 

0E01-
0E05 

Wavelength not found in table 
The specified wavelength is not detected in the instrument’s filter table. The last 
number is the filter set number in the assay protocol. 
Probable Causes: 
• Assay wavelength does not match the filter table. 
Run system test. Verify that wavelengths in the filter wheel match settings in the 
filter table (see Chapter 2). 

0F00- 
0F05 

Filter signal out of range 
The filter (1-5) has a signal that is out of range.  
Probable Causes: 
• This indicates a light level problem with one or more filters. 
• A “UV” filter may have been installed in a non-UV instrument. 
• A blank filter may be incorrectly installed in a filter position. 
• Verify that filters in the filter wheel match settings in the filter table (see 

Chapter 2). 

1000 Configuration data missing 
Required reader configuration data was missing at the beginning of the  
self-test.  
Possible Causes: 
• Necessary configuration data was not downloaded or was downloaded 

incorrectly. 
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Code General Error Codes - Description and Probable Causes 
• The filter values defined in the reader software do not match the contents of 

the filter wheel; update the filter values (see Using the Utility Options in 
Chapter 3). 

1100 Failed configuration checksum test 
The stored checksum value from the configuration data does not match the actual 
checksum of the current configuration data.  
Probable Cause: 
• The configuration data has changed and the checksum stored is no longer 

valid. The error is produced when outdated versions of assay definition 
software are used to create an assay configuration file. 

• File is incompatible with the operation code within the reader’s memory. 
Recreate the assay definition using the correct version of assay definition software 
and re-download the software. 

1201 Calibration value missing 
Probable Causes: 
• Filter table was updated but System Test was not run. Run a system test. 

1300 Motor not homed successfully 
If the motor is not correctly homed, the instrument sends an error and exits the 
function.  
Probable Causes: 
• Errors 0200 or 0300 have been ignored. Refer to the Probable Causes for 

these errors. 

 
 

Fatal Error Codes (A100-A900) 

Fatal Errors indicate conditions that require immediate attention. If a fatal error code is 
displayed, contact BioTek’s Technical Assistance Center for further instructions. Refer to 
Chapter 1 for contact information. 

 

Code Description 

A100 Task control block not available 

A200 Read already in progress 

A300 Device not available 

A304 Printer device not available 

A400 Failed code checksum on power-up 

A500 Code flash readback timed out 

A600 Quick flash configuration timed out 

A900 Memory Manager corruption 

 



 

Appendix A 

Report Format 

This appendix contains examples of reports that can be generated 
and/or printed from the ELx800. See Printing Reports in Chapter 3 
for details on how to print these reports.  
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Overview 

 Important! The 'OUT' indication on reports means the OD for 
an individual well, or the average OD for a group of wells, falls 
outside the minimum/maximum OD range defined for the 
assay. For the Quick Read assay on the ELx800, this range is  
-3.0 OD to +3.0 OD. For assays defined onboard by a user 
(Assay 02 – Assay 55), it is -4.0 OD to +4.0 OD.  

 

The following pages contain examples of reports that can be generated and/or printed 
directly from the reader. For details on how to print these reports, refer to Specifying 
Data Output and Reporting Options in Chapter 3.  

In addition, an Assay List, Assay Definition, Map, and Result can be printed by 
choosing REPORT from the Main Menu. 
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Samples with calls on a Matrix Report 
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Curve Fit Report 
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Samples with calls on a Column Report 
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A Column Report, without samples 
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Panel Report 
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Assay Detail Report (Sheet 1 of 2) 
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Assay Detail Report (Sheet 2 of 2) 
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Appendix B 

Instructions for Programming a 
New Assay 

This appendix provides two sample assay kit instructions with step-by-
step instructions for programming each assay: one with a ratio 
transformation calculation and a POS/NEG cutoff determination, and 
another with a standard curve.  

These examples are based on real assays; however, the results have not 
been verified on any clinical kits. The kit instructions are provided so that 
users can see how it is possible to translate the kit wording into an 
ELx800 assay program. For clarity, only the user menu choices from the 
reader screens are shown. See Chapter 3 for details. 

L Important! The user is responsible for programming the 
reader properly according to their specific kit instructions, and 
for verifying that the calculations are performed correctly. 

 

Appendix C ......................................................................... 111 
Instructions for Programming a New Assay ............................. 111 
Sample ANA Screen Enzyme Immunoassay Kit ........................ 112 
Sample Human Anticardiolipin IgG Enzyme Immunoassay Kit .... 116 
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Sample ANA Screen Enzyme Immunoassay Kit 

This sample demonstrates the use of transformations and cutoffs. 

Intended Use 

This assay is designed for the in vitro screening of human serum for the presence of 
specific IgG antinuclear antibodies (ANAs), to aid in diagnosing certain systemic 
rheumatic diseases. Sufficient materials are supplied to allow a maximum of 93 
samples to be screened in single, with positive, cutoff, and negative controls. 

Background 

Antinuclear antibodies occur in a large number of patients with systemic rheumatic 
diseases. These diseases are characterized by the presence of one or more ANAs. 

Sera positive on this ANA kit should be tested for the specific autoantibodies 
indicative of the various systemic rheumatic diseases. 

Principle of the Assay 

Microwells are pre-coated with purified antigens. The prediluted controls and diluted 
patient samples are added to the wells, and autoantibodies recognizing one or a 
combination of antigens bind during the first incubation. After washing the wells to 
remove all unbound proteins, IgG conjugate is added. The conjugate binds to the 
captured human autoantibody, and the excess unbound conjugate is removed by a 
further wash step. Substrate is added that causes a blue reaction, thereby exposing the 
bound conjugate, and producing an intensity proportional to the concentration of 
autoantibody in the sample. Phosphoric acid is added to each well to stop the reaction. 
This produces a yellow end-point color, which is read at 450 nm. 

Materials Supplied 

• Instruction Leaflet: Giving full assay details. 

• QC Certificate: Indicating the expected performance of the batch. 

• ANA Coated Wells: 12 x 8 well strips coated with purified antigens. 

• Type III Wash Buffer 20x Concentrate: 1 bottle containing 50 mL of a concentrated 
buffer for washing the wells. 

• Type III Sample Diluent: 2 bottles containing 50 mL of buffer for sample dilution. 
Ready to use. 

• ANA Positive Control: 1 bottle containing 1.8 mL of diluted stabilized human 
serum. Ready to use. 
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• ANA Cutoff Control: 1 bottle containing 1.8 mL of diluted stabilized human 
serum. Ready to use. 

• ANA Negative Control: 1 bottle containing 1.8 mL of diluted stabilized human 
serum. Ready to use. 

• ANA Conjugate: 1 bottle containing 12 mL of peroxidase labeled antibody to 
human IgG. Colored red, ready to use. 

• TMB Substrate: 1 bottle containing 14 mL TMB substrate. Ready to use. 

• Stop Solution: 1 bottle containing 14 mL of 3M Phosphoric acid. Ready to use. 

Additional Materials and Equipment – Not Supplied 

• Automatic Microplate Plate Washer: This is recommended; however, plate 
washing can be performed manually. 

• Microplate Reader: Capable of measuring optical densities at 450 nm referenced on 
air. 

• Distilled or Deionized Water: This should be of the highest quality available. 

• Calibrated Micropipettes: For dispensing 1000, 100, and 10 µL. 

• Multichannel Pipette: Recommended for dispensing 100 µL volumes of conjugate, 
substrate, and stop solution. 

• Glass/Plastic Tubes: For sample dilution. 

Quality Control 

For an assay to be valid, all the following criteria must be met: 

• Cutoff as well as Positive and Negative controls must be included in each run. 

• The OD of the cutoff and the ANA result of the Negative and Positive Controls 
should be in the ranges specified on the QC Certificate. 

• For example: The absorbance of the Positive Control must be greater than 1.200 
OD. The absorbance of the Negative Control must be less than 0.300 OD. 

 If the above criteria are not met, the assay is invalid and the test 
should be repeated. 

Calculation of the Sample Results 

Use the following formula to calculate the ANA result for each sample: 

Control or sample OD 
x 10 = Control or sample value (U/mL) 

Cutoff control OD 
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Expected Values 

The normal range was determined on serum from 200 normal adult blood donors. The 
cutoff control has been set at a point equivalent to the upper normal limit, or a cutoff 
level of 10 U/mL. 

The ranges are provided as a guide only. ELISA assays are very sensitive and capable 
of detecting small differences in sample populations. It is recommended that each 
laboratory determine its own normal range, based on the population techniques and 
equipment employed. 

 

ANA Result Interpretation 

< 10.0 Negative 

> 10.0 Positive 

 

Programming the Assay on the ELx800  

From the Main Menu, select DEFINE. Select the assay name and edit the name if 
desired. At the DEFINE menu: 

 
  STEP      COMMENTS 

To program the reading method, press: 

METHOD  

WAVELENGTH (Dual or Single): Single  

MEASURE (Wavelength): 450  

PLATE TYPE: 96  

To program the plate map, press: 

MAP  

AUTO: “Auto” mapping is normally preferred, 
because it fills in the well IDs logically 
and automatically after determining 
which direction to map and how many 
wells to fill. 

DOWN: Maps the wells down the column 

DOWN: Locates replicates in a vertical 
orientation down the column 

A01: Begins mapping at well location A01 

BLANK MAP: AIR Choose to blank on “AIR” if no blank 
wells are required 
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  STEP      COMMENTS 

NUMBER STDS: 00  

NUMBER CTLS: 03  

CONTROL 1: PC  

CONTROL 2: CTL1 Suggested choice for the cutoff control 

CONTROL 3: NC  

NUMBER OF REPLICATES  

PC: 01  

CTL1: 03   

SAMPLES: 91 User-defined; recommendation is to fill 
the entire plate 

SAMPLE REPLICATES: 01  

Use the MAP and MATH keys to create the control validation formula: 

FORMULA  

VAL  

CONTROL: 

PC;x > 1.200 

NO. OF REPLICATES: 01 

NC;x < 0.300 

NO. OF REPLICATES: 01 

When defining control validation 
formulas, use “PC” to indicate the 
criterion for each of the PC replicates, 
and “PC;x” to indicate the average of the 
Positive Control replicates. 

To create the plate transformation for CALC, divide the ANA result by a cutoff 
standard. 

FORMULA 

*MORE 

TRANS-VAR 

 

SCOPE VARIABLE (SMP or OD) Select OD to advance to the formula 
definition screen and define the 
transformation variable (Tvar) 

FORMULA  

CTL1;X  Defining TRANS VAR = CTL1;X isolates 
the OD value for CTL1;X for use in 
transformation 

TRANS:  

FORMULA: (OD/TVAR)*10 Converts all OD values on plate to  
“ANA Result” per kit insert instructions 

To define a cutoff formula for Positive and Negative calls: 

FORMULA  

CUTOFF: 10.0  

GREYZONE: 00%  

SAMPLE > CUTOFF + 00%: POS  
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Sample Human Anticardiolipin IgG Enzyme 
Immunoassay Kit  

This sample demonstrates the use of a standard curve and cutoffs. 

Intended Use 

This assay is intended for the in vitro measurement of IgG anticardiolipin antibodies in 
human serum, as an aid in the diagnosis of antiphospholipid syndrome (APS). 

Sufficient materials are supplied to allow a maximum of 41 samples to be tested in 
duplicate or 89 in single, with a standard curve and positive and negative controls. 

Background 

Anticardiolipin antibodies are found in a wide range of conditions either transiently, in 
some infectious diseases, or more persistently in autoimmune diseases such as 
systemic lupus erythematosus (SLE) and antiphospholipid syndrome (APS). 
Anticardiolipin antibodies have also been associated with a range of clinical conditions 

including fetal loss, endocarditis, stroke, heart attack and autoimmune haemolytic. 

Principle of the Assay 

Microwells are precoated with cardiolipin and cofactor. Standards, controls, and 
patient samples are added to the wells, and autoantibodies recognizing cardiolipin 
bind during the first incubation. After washing the wells to remove all unbound 
proteins, conjugate is added. The conjugate binds to the captured human antibody, 
and the excess unbound conjugate is removed by a further wash step. Substrate is 
added that causes a blue reaction, thereby exposing the bound conjugate and 
producing an intensity proportional to the concentration of autoantibody in the 
sample. Phosphoric acid is added to each well to stop the reaction. This produces a 
yellow end-point color, which is read at 450 nm. 

Materials Supplied 

• Instruction Leaflet: Giving full assay details. 

• QC Certificate: Indicating the expected performance of the batch. 

• Cardiolipin Coated Wells: 12 break-apart 8-well strips coated with bovine 
cardiolipin antigen. The plate is packaged in a re-sealable foil bag containing two 
desiccant pouches. 

• Type II Sample Diluent: 2 bottles containing 50 mL of buffer for sample dilution. 
Colored yellow, ready to use. 

• Type II Wash Buffer (20x Concentrate): 1 bottle containing 50 mL of a 20-fold 
concentrated buffer for washing the wells. 
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• Cardiolipin IgG Standards: 5 bottles each containing 1.2 mL of diluted human 
serum, with the following concentrations of anticardiolipin autoantibody: 100, 50, 
25, 12.5, 6.25 GPL U/mL. Ready to use. 

• The standard set is calibrated against the Louisville APL reference preparation. 

• Cardiolipin IgG Positive Control: 1 bottle containing 1.2 mL of diluted human 
serum. The expected value is given on the QC certificate. Ready to use. 

• Cardiolipin Negative Control: 1 bottle containing 1.2 mL of diluted human serum. 
The expected value is given on the QC certificate. Ready to use. 

• Cardiolipin IgG Conjugate: 1 bottle containing 12 mL of purified peroxidase 
labeled antibody. Colored red, ready to use. 

• TMB Substrate: 1 bottle containing 14 mL TMB substrate. Ready to use. 

• Stop Solution: 1 bottle containing 14 mL of 3M phosphoric acid. Ready to use. 

Additional Materials and Equipment – Not Supplied 

• Automatic Microplate Plate Washer: This is recommended; however, plate 
washing can be performed manually. 

• Plate Reader: Capable of measuring optical densities at 450 nm referenced on air. 

• Distilled or Deionized Water: This should be of the highest quality available. 

• Calibrated Micropipettes: For dispensing 1000, 100, and 10 µL. 

• Multichannel Pipette: Recommended for dispensing 100 µL volumes of conjugate, 
substrate, and stop solution. 

• Glass/Plastic Tubes: For sample dilution. 

Quality Control 

For an assay to be valid, all the following criteria must be met: 

• Standards and the positive and negative controls must be included in each run. 

• The values obtained for all the controls should be in the ranges specified on the 
QC Certificate. 

• The curve shape should be similar to the standard curve, shown on the QC 
Certificate. 

• If the above criteria are not met, the assay is invalid and the test should be 
repeated. 

Calculate Mean Optical Densities (for assays run in duplicate only) 

For each standard, control, and sample, calculate the mean OD of the duplicate 
readings. The user must verify that the percentage coefficient of variation (%CV) for 
each duplicate OD is less than 15.0%. 
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Plot Calibration Curve 

The calibration curve can be plotted either automatically or manually as follows by 
plotting the anticardiolipin autoantibody concentration on the log scale against the OD 
on the linear scale for each calibrator: 

• Automatic - Use appropriately validated software, and the curve fit that best 
fits the data. 

• Manual - Using log/linear graph paper, draw a smooth curve through the 
points (not a straight line or point to point). 

Treatment of Anomalous Points 

If any one point does not lie on the curve, it can be removed. If the absence of this 
point means that the curve has a shape dissimilar to that of the sample calibration 
curve, or more than one point appears to be anomalous, then the assay should be 
repeated. 

Calculation of Autoantibody Levels in Controls and Samples 

Read the level of the anticardiolipin autoantibody in the controls and diluted samples 
directly from the calibration curve. The control values should fall within the range 
given on the QC Certificate. 

 The standard values have been adjusted by a factor of 100 to account 
for a 1:100 sample dilution. No further correction is required. 

Assay Calibration 

The assays are calibrated against the Louisville reference LAPL-GM-100. One GPL 
unit is defined as the cardiolipin binding activity of 1 µg/mL of an affinity 
purified IgG anticardiolipin preparation from a standard serum. The Louisville 
reference center recommends the following positive discrimination criteria 
according to the recommendation of the 2nd International Anticardiolipin 
Workshop. 

Criteria Range (GPLU/mL) 

High Positive  > 80 

Medium Positive  ≥ 20-80 

Low Positive  ≥ 10, < 20 
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Results Interpretation 

The association between low positive levels of anticardiolipin antibodies and clinical 
findings is unclear. 

Normal population studies indicate that there is a higher prevalence of IgM positives 
in the normal population than IgG, 9.4% and 6.5%, respectively. In normal pregnancy, 
the levels are higher still at 17.0% (IgM) and 10.6% (IgG). 

Expected Values 

The normal range was determined on serum from 102 normal adult blood donors. The 
ranges below are provided as a guide only. ELISA assays are very sensitive and 
capable of detecting small differences in sample populations. It is recommended that 
each laboratory determine its own normal range, based on the population techniques 
and equipment employed. 

IgG Anticardiolipin 

< 11 GPLU/mL Negative result 

> 11 GPLU/mL Positive result 

 
 

Programming the Assay on the ELx800 

From the Main Menu, select DEFINE. Select the assay name and edit the name if 
desired. At the define menu, follow steps below: 

 

 STEP      COMMENTS 

To program the reading method, press: 

METHOD  

WAVELENGTH (Dual or Single): Single  

MEASURE (Wavelength[s] to use): 450  

PLATE TYPE: 96  

To program the plate map, press: 

MAP  

AUTO  

DOWN  

DOWN  

A01  
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 STEP      COMMENTS 

BLANK MAP: AIR  

NUMBER STDS: 05  

NUMBER STD REPLICATES: 01 
CONCENTRATIONS: 
 STD1:  6.25 
 STD2:  12.5 
 STD3:  25 
 STD4:  50 
 STD5: 100 
NUMBER CTLS: 02 

 

CONTROL 1: PC  

CONTROL 2: NC  

NUMBER OF REPLICATES  

PC: 01  

NC: 01  

SAMPLES: 89  

SAMPLE REPLICATES: 01  

To define a cutoff formula for Positive and  
Negative calls: 

Kit instructions specify that samples 
with concentration values greater 
than 11 should appear as positive. 
The ELx800 software calculates the 
cutoff based on absorbance value or 
transformed value (see the previous 
example) and cannot calculate based 
on concentration. The technician 
must make the positive or negative 
determination visually, based on the 
calculated concentration results. 

Curve: 4P As a general guideline, choose 
“linear” if you expect a straight-line 
result. Choose “4P” for all others, 
unless otherwise specified by the kit 
instructions.  

The reader will automatically 
calculate the concentrations of the 
samples when the assay is run. 
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